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The ableton Team Says: Thank You

Live is the result of musicians wanting a better way to compose, improvise, and perform
music using a computer. A lot of effort has been put into making it easy and fun to use,
yet still capable of helping you create music with unlimited depth and sophistication.
This effort continues, even as you are reading these lines. . . in fact, a new, improved
Live version might already be available for download! Please check on our web site now.

We hope you enjoy using Live, and that it enhances your creative process. Should you
have suggestions about how we can improve Live, please let us know.

Your ableton team.

http://www.ableton.com/index.php?main=downloads
mailto:contact@ableton.com
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How to Use This Manual

The Live manual consists of two chapters: chapter one is a tour of Live, which we
strongly recommend for first-time users; chapter two provides reference on the Prefer-
ences, Effects, Menu, MIDI Implementation, and keyboard shortcuts.

We want this documentation to be as helpful as possible. Should you find anything
unclear or incorrect in this manual, please let us know.

mailto:documentation@ableton.com


Chapter 1

A Tour of Live

1.1 First Steps

When you have installed Live and run it for the first time, you will be presented with
the Welcome Dialog.

If you own Live, you can unlock Live using this dialog. For details on unlocking and
copy protection, please see the respective manual section (see Live’s Copy Protection).

If you do not (yet) own Live, please click the “Run Demo” button to proceed. You will
be able to work with all of Live’s features with the exception of saving, rendering to
disk, and resampling.

1



1.1. FIRST STEPS 2

1.1.1 The Live Screen

Most of your work in Live happens in the main Live screen. This screen consists of a
number of views. Each view manages a specific aspect of your project.

The Live Screen.
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One view is always there: the Control Bar, located at the top of the screen, contains
global controls for tempo, the metronome, synchronization, tape deck-like transport,
and system monitoring.

As screen space is limited, the other Live views cannot all be up at the same time–
even if you run Live in full screen mode (see Full Screen), which is toggled by pressing
the F11 key. Rather than cluttering the screen with overlapping windows, Live offers a
number of fast methods to access each view and configure the screen according to your
needs:

A View Chooser

Each one of the chooser buttons at the screen borders calls up a specific view; click this
one, for instance, to access the Live effects.

A View Unfold Button

To hide a view, thus freeing up screen space, click on the triangular-shaped button next
to it. To restore the view, click the button again.

Adjusting the Main Window
Split.

You can adjust the main window’s horizontal split by dragging.

This tour will take you through all the views, and explain their purposes. Let’s start
with the Info View, which is tremendously helpful when working with Live.
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1.1.2 Getting Help from the Info View

The Info View provides information about the area of the interface currently under the
mouse.

The Info View.

If you can’t remember a particular control or view function, the Info View tells you what
it is and what you can expect it to do. If you need more information, please consult
the manual.

1.1.3 Opening a Live Set from the Browser

Live has a number of built-in browsers.

A File Browser Chooser

The three File Browsers are used for navigating the file system; pre-listening and loading
samples (see Browsing and Pre-Listening); and for opening Live documents (so-called
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Live Sets);

The Live Effects Chooser

The Live Effects browser contains all built-in effects (see The Live Effects);

The Plug-In Effects Chooser

The Plug-in effects browser gives you access to your VST Plug-ins (see Using VST Plug-
ins).

To start with, let’s load Live’s demo song. After installation, the topmost browser should
contain an item called “Live Demo Arrangement.als”. Please double-click this Live Set
to open it.

1.1.4 Arrangement and Session View

Live has two main views, which can be toggled by pressing the computer’s tab key, or
by clicking their respective choosers.

The Arranger View Chooser.

The Arranger View displays the Arrangement, which contains music laid out along a song
timeline, like a multitrack tape.
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A piece of music laid out in
the Arranger View.

Much like you would record onto tape, you can record multiple tracks of audio into the
Arrangement (see Recording Audio). Unlike music stored on tape (or in a traditional
digital audio workstation), you can change your recordings’ tempo at any time. The
Arranger View is a powerful audio editing tool that easily lets you combine and arrange
audio of all types: loops, sound effects, and complete pieces of music.

The Session View Chooser.

The Session View is a vertical layout of tracks, much like the channel strips of a mixing
console. In fact, the Session View acts as Live’s mixer (see Mixing and Effects).
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The Session View acts as
Live’s Mixer.

The Session View also hosts clips for live playing, which you can hide or show by
toggling the View menu’s “Clips” option. Session clips offer many exciting possibilities
for creating and performing music, which we will investigate soon (see Playing Session
Clips).

The Session View hosts Clips
for live playing.

Your session playing can be recorded into the Arrangement, allowing for an improvisa-
tional approach to composing songs and scores.

1.1.5 Clips and Tracks

Please switch to the Arranger View and press the computer’s space bar to listen to
the demo song. As you listen to the demo song, you can observe Live traversing an
arrangement of clips along the song timeline.



1.1. FIRST STEPS 8

A clip in the Arranger View.

A clip represents a piece of sound. The clip does not actually contain the sound; instead,
it references a sample file on the computer’s hard disk. When the clip is played, it tells
Live what part of the sample should be played, and how:

• as a loop or as a “one-shot”;

• in sync with the current song tempo, or un-synced;

• at what pitch;

• . . . and many other options.

The respective settings are made in the Clip View which appears at the bottom of the
screen when a clip is double-clicked.

The Clip View.

Many interesting variations of a sample can be created just by changing the clip prop-
erties, without generating bulky new audio data. We will be talking about adjusting the
clip properties later (see Setting Clip Properties).

Clips reside in tracks, which appear as horizontal rows in the Arranger View, and as
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vertical columns in the Session View. (Please note that both views display the same set
of tracks).

Apart from hosting clips, tracks are important because they contain a mixer stage and
effects to process the audio delivered by the clips. A track’s effects are accessed via
the Track View, which appears at the bottom of the screen when the track’s name is
double-clicked.

Effects in the Track View.

General concepts of mixing and effects are covered by the respective manual section
(see Mixing and Effects); Live’s built-in effects are discussed in the reference section
(see The Live Effects).

To create additional tracks, use the Insert Track command (see Insert Track). To delete
a track, click on its name and choose Delete from the Edit menu. To rename a track,
click on the track name and select the Edit Menu’s Rename command. Tracks can be
re-ordered by dragging their names.
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1.2 Navigation and Transport

1.2.1 Arranger Navigation

Live offers several fast methods for zooming and scrolling the Arranger display:

• to zoom in and out around the current selection, use the computer keyboard’s +
and - keys;

• to smoothly change the zoom level, click and drag vertically in the song time ruler
above the track display (you can also drag horizontally to scroll the display);

• for general navigation, click and drag both horizontally and vertically in the
Overview.

Now take a closer look at the Arranger Overview.

The Arranger Overview.

The Arranger Overview is like a “bird’s-eye view” of your music. It always shows the
complete piece, from start to end. The black rectangular outline represents the part of
the Arrangement that is currently displayed in the Arranger display below. The Arranger
Overview works somewhat like an advanced scroll-bar:

• to scroll the display, click within the outline and drag left or right (to zoom out
and in, drag up and down);

• to change the displayed part of the Arrangement, drag the outline’s left and right
edges;
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• to see a specific part of the Arrangement in more detail, click on it in the Overview
and drag downwards to zoom in around that part. Note that you can also drag
horizontally to scroll the display. Using this method, you can zoom and scroll to
focus around any part of the Arrangement with just one mouse motion.

The Follow Switch.

To have the Arranger display follow the song position and "turn the page" automatically,
turn on the Follow switch, or use the Follow command from the Option menu (see
Follow).

1.2.2 Transport

The Start Button.

To start playback, click the Control Bar’s Start button.

The Stop Button.

Stop playback by clicking the Stop button.

You can also toggle playback on and off by pressing the space bar. To continue playback
from the position where it last stopped, hold Shift while pressing the space bar.
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The Song Start Marker.

You can easily set the playback position by dragging the song start marker; this also
works while Live is playing.

The Song Position Fields.

Or, adjust the song position numerically: the Control Bar’s song position fields shows
the song position in bars-beats-sixteenths. To change the values:

• click and drag up or down in any of these fields;

• click and type a number, then hit the Enter or Return key;

• click and increment or decrement the value with the up and down arrow keys.

All Live controls with a value display use these standard methods for entering values.
In addition, compound value boxes (e.g., song position fields) allow using the left and
right arrow keys, or “.” or “,” to jump between the fields.

1.2.3 The Song Loop

The Song Loop Switch.



1.2. NAVIGATION AND TRANSPORT 13

For Live to repeatedly play a section of the Arrangement, activate the Arrangement Loop
by clicking on the Control Bar’s Song Loop Switch.

The Loop Controls.

You can set the loop markers numerically, using the Control Bar fields: the left-hand set
of fields determines the loop start position, while the right set of fields is the length of
the loop.

The Arranger’s Loop Markers.

Alternatively, you can drag the Arranger’s Loop marker: dragging the marker’s left and
right ends sets the loop start and end points; dragging between the ends moves the
loop without changing its length.

1.2.4 Setting the Tempo

Unlike music stored on tape or in a traditional digital audio workstation, the music
in Live remains “elastic” at all times. Live is capable of time-warping samples while
streaming them from disk so as to synchronize them to the current project tempo. This
happens without affecting the pitch, which can be changed independently. Mixing and
matching audio from different origins is therefore extremely easy.

The Control Bar’s Tempo
Control.

The Control Bar’s Tempo control allows you to change the playback tempo of your Live
Set at any time, in Real-time. You can even automate the tempo (see Editing the Tempo
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Automation) to create smooth or sudden tempo changes along the song timeline.

You can have an external sequencer (or drum machine) play along with Live, or have Live
play along with the sequencer. The respective settings are made in the MIDI Preferences
(see MIDI Preferences), and the EXT switch next to the tempo control is activated to
have Live follow an external MIDI clock source.

1.2.5 Tapping the Tempo

The Tap Button.

You can use Live’s Tapping function to set the tempo at any time. As you click the
Control Bar’s Tap Button button once every beat, the audio in the Live Set will follow
your tapping.

The Key Map Mode Switch.

It’s better to assign the Tap button to a computer key than using the mouse. Click
on the Control Bar’s KEY switch to enter Key Map Mode; then, select the Tap button;
press the key you would like to use for tapping; click the KEY switch again to leave Key
Map Mode. The assignment will take effect immediately. The Tap button can also be
assigned to a MIDI note or controller, like a foot switch, in a similar fashion (see MIDI
Implementation).

Although Live responds to your tapping immediately, it does apply some degree of
inertia to prevent sluggish behaviour in the software. The more taps Live receives in a
row, the more precisely it will be able to conclude the desired tempo.
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You can also use tapping to count-in: if you are working at a 4:4 signature, it takes
four taps to start song playback at the tapped tempo.

1.3 Managing Samples

A Sample is a standard WAV or AIF sound file. On the Macintosh, Live is capable
of reading samples in Sound Designer II format, as well. Live can combine mono or
stereo samples of any length, sample rate, or bit depth, without prior conversion. As
Live plays the samples directly from disk, you can work with a large number of (large)
samples without running into RAM memory limitations.

1.3.1 Browsing and Pre-Listening

Samples are searched and imported from disk using Live’s on-board browsers, which can
be pointed to any folder location on the computer:

The File Browser’s Folder-Up
Button.

The Folder-Up Button moves up one step in the disk hierarchy. Clicking this enough
times will take you to your computer’s desktop. Now, you can browse through the disk’s
folders.

The File Browser’s Root
Button.
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After locating the folder with the samples you want to use, you may optionally make
this folder the browser root by clicking the Root Button. Note that there are three file
browsers which you can set up to point to commonly used folders.

The Pre-listening Switch.

Activate the browser’s Pre-listening Switch.
Selecting a sample to
pre-listen.

Click on the samples (or use the arrow up and down keys) to select and listen to them.

If your audio hardware offers multiple audio outs, you can privately audition samples
via headphones connected to a separate pair of outs– while the music continues to play.
The output bus for pre-listening is set using the Audio Preferences’ Pre-Listen menu (see
Pre-Listen).

If you like a sample, drag it into the open Live Set.

1.3.2 Renaming and Deleting Samples

The browser can also rename and delete files:

• to rename a sample selected in Live’s browser, choose Rename from the Edit Menu;

• to delete the selected sample(s), choose the Edit Menu’s Delete command. Delet-
ing samples within Live moves them to the system trash, where they can be
recovered if needed.
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1.3.3 The Sounds Folder and Self-Containing

The Sounds Folder is a Live Set’s private location for storing samples. All samples that
are recorded into a Live Set end up in this Live Set’s Sounds folder. Live offers a
convenient method for gathering all samples that are referenced by a Live Set in this
folder: when you choose the File menu’s Save Set Self-Contained command, Live copies
all externally referenced samples there. After self-containing the files, there are no
longer references to samples spread over one or more hard drives. You can backup the
Live Set along with its Sounds folder, or send them to collaborators via the Internet,
and all samples used in the project will be included.

The Sounds folder for “My Live Set” is called “My Live Set Sounds”. It is located next to
(in the same folder as) “My Live Set.”

1.3.4 Analysis Files (.asd)

An Analysis File is a little file that Live creates when a sample is recorded, or dragged
into the program for the first time. The analysis file contains data gathered by the
program to help optimize the stretching quality, as well as speed up the waveform
display.

In addition, an analysis file can store a Default Clip for the sample: clicking the Clip
View’s Save button will store the current clip’s analysis file with the sample. Next
time the sample is dragged into Live, it will appear with those clip settings. This is
particularly useful for retaining the Warp Marker settings (see Setting Warp Markers)
with the sample.
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The analysis file’s name is the same as the associated sample, but with an added “.asd”
extension. Live puts this analysis file in the same folder as the sample. Note that
you can suppress the creation of .asd files by unchecking the Create Analysis Files (see
Create Analysis Files for Samples) option in the Misc Preferences. All data (except for
the Default Clip) can be re-created by Live if the .asd file is missing.

1.3.5 Offline and Lost Samples

When loading a Live Set that references samples missing from their referenced locations,
Live issues a warning message and asks whether you want to locate the missing samples.

If you don’t, the Live Set will open anyway, with the missing samples marked “Offline.”
The Live Set will play silence in place of the offline samples. You can find the missing
files by selecting a clip that is referencing an offline sample, and clicking the Clip View’s
Replace button (see Using the Sample-Related Commands).

To avoid missing samples, we highly recommend saving your Live Set as self-contained
(see The Sounds Folder and Self-Containing).

1.4 Editing Arrangements

In Live’s Arranger View, music is represented by clips, waveforms, and envelopes. We
will now look at Live’s powerful methods for editing musical material in the Arranger
View.
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First, let us introduce a shortcut that often comes in handy when editing music in the
Arranger View: to play what is currently selected, or to play from the flashing insert
mark, press Option - space bar on a Mac; Control - space bar on a PC.

1.4.1 Non-Destructive Editing

You cannot destroy anything using these methods: thanks to Live’s unlimited Undo
history (see Undo) you can always return to the previous state of your Live Set. Fur-
thermore, none of your editing in Live alters the audio samples stored on your hard
drive. A clip simply references (points to) external audio samples.

1.4.2 Arranging Clips

A piece of audio is represented by a clip box sitting at some song position in one of
Live’s tracks.

Moving a clip.

Dragging a clip moves it to another song position, or track.

Changing a clip’s length.

Dragging a clip’s left or right edge changes the clip’s length.
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Clicking a clip selects the clip for editing using one of the Edit menu’s commands (see
The Edit Menu). Note that learning the Edit menu’s keyboard shortcuts can save you a
lot of mouse motion. The Edit menu commands can apply to more than one clip at a
time: extend the selection by shift-clicking on another clip in the same track or another,
or in the Arranger display’s background.

1.4.3 Using the Editing Grid

The Snap to Grid Switch.

If the Snap to Grid Switch is on, the cursor will snap to grid lines that represent the
meter subdivisions of the song tempo. This grid adapts to the zoom level.

The Quantization Pop-Up

If Snap to Grid is off, the cursor will snap to the fixed quantization grid selected from
the Control Bar’s quantization pop-up menu. To work without snapping, choose “None”
from the pop-up. You can also change the quantization grid from the Options menu, or
with keyboard shortcuts.

1.4.4 Editing Audio Waveforms

A Track Unfold Button.
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To display the audio played by a clip, “unfold” its track by clicking the triangular button
next to the track name.

Adjusting an unfolded
track’s height.

Notice you can adjust the height of the unfolded track by dragging the split line below
the unfold button.

Now, you can drag to select a portion of the audio waveform, and choose one of the
Edit menu’s commands (see The Edit Menu) to perform a particular editing operation.

The result of splitting a clip.

By choosing the Split command (see Split), for instance, you can divide a clip into
smaller parts.

There is a handy shortcut for selecting time within a clip that does not require unfolding
the track: click on a clip box with both Alt (PC) / Option (Mac) and Control (PC) /
Command (Mac) held.
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1.4.5 Editing Automation Envelopes

The envelopes for a track’s mixer and effect controls are displayed in the same place
as the audio waveform. Unfolding a track reveals two pop-up menus (below the unfold
button) which can select a control for envelope display:

The Automation Device
Pop-Up.

The top menu selects the track mixer, one of the track’s effects, or “None” to hide the
envelope.

The Automation Control
Pop-Up.

The bottom menu selects a control from the unit chosen in the top menu.

A faster way to choose a control for envelope display is to simply click on it, but be
careful not to accidentally change the value.

In the envelope display, the vertical axis represents the control value and the horizontal
axis represents time. The value axis is discontinuous for switches and radio buttons.

Here is how to work with envelopes:

• Double-click on the envelope to create a new breakpoint.

• Click and drag a breakpoint to move it to the target location. If the breakpoint
you are dragging is in the current selection, all other breakpoints in the selection
will follow the movement.

• Double-click a breakpoint to delete it.



1.4. EDITING ARRANGEMENTS 23

• Shift-drag a breakpoint across the time axis to erase neighboring breakpoints.

To move all breakpoints
within the selection, drag
any one of them.

In addition, there is a number of useful Edit Menu commands for editing envelopes (see
The Edit Menu). Again, it pays to learn the keyboard shortcuts for these commands,
which is made easier by remembering the following tip: the commands pertaining to
the envelope have the same shortcuts as the “general” ones, but you simply hold the
Alt (PC) / Option (Mac) modifier in addition.

The Lock Envelopes Switch.

When moving clips, Live normally moves all automation with the clip. Sometimes, you
might want to lock the envelopes to the song position rather than to the audio; the
Arranger’s Lock Envelopes Switch does just that.

1.4.6 Editing the Tempo Automation

The ability to dynamically stretch and compress audio to track any tempo, or tempo
variation, is one of Live’s specialities. In Live, the song tempo is just another automated
control.

To edit the song tempo envelope, unfold the Master Track (see Send Tracks and the
Master Track), choose “Mixer” from the top envelope chooser menu, and “Song Tempo”
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from the bottom one.

The tempo envelope.

When adjusting the tempo envelope, you might want to scale the value axis display,
which is the function of the two value boxes below the envelope choosers: the left box
sets the minimum, and the right box sets the maximum tempo displayed, in BPM.

1.5 Mixing and Effects

1.5.1 The Live Mixer

Live includes a mixer section which is accessible from two views:

The Arranger Chooser.

In the Arranger View, the mixer appears as a vertical strip to the right of the track area.

Adjusting an unfolded
track’s height.
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To display all mixer controls for a track, unfold the track and adjust its height accord-
ingly.

The Session Chooser.

The Session View is a standard vertical mixer layout. Uncheck “Clips” from the View
menu to hide the clips from the Session View mixer, thus creating a more spacious mixer
layout that fits more tracks on screen.

You’ll likely find the Session View mixer more intuitive than the Arranger mixer, which
is nonetheless useful as it displays everything in one place. This comes in handy when
you work with automation (see Recording Automation). Note that the View Menu allows
you to show and hide the mixer, while the Tab key toggles between the Arranger and
Session Views.

Let’s look at the mixer controls:

The Session mixer (left) and
the Arranger mixer (right)
are two views at the same
thing.

• To mute the track’s output, turn off the Track Active switch.

• The Solo switch solos the track by muting all other tracks, but can also be used
for pre-fade listening (see PFL Switches).
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• If the Monitor switch is on, you monitor the track’s input signal.

• If the Arm switch is on, the track is record-enabled. We will learn about recording
audio shortly (see Recording Audio).

• The Meter shows the track’s RMS (average) and peak output level. However, it
shows the input level while monitoring.

• The Gain control adjusts the track’s output level.

• The Pan control positions the track’s output in the stereo field. To reset the pan
control to center, click on the little triangle.

1.5.2 Using Live’s Crossfader

Live includes a crossfader that can create smooth transitions between clips playing on
different tracks. Live’s crossfader works like a typical DJ mixer crossfader, except that it
allows crossfading not only two, but any number of tracks– including the sends.

The crossfader is accessed via the Session View mixer.

The Crossfader.

The crossfader is a horizontal slider which can be mapped to any continuous MIDI
controller (absolute or incremental).
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A track’s Crossfade Assign
Switches.

Each track has two crossfader assign switches, A and B. The track can have three states
with respect to the crossfader:

• If neither assign switch is on, the crossfader does not affect the track at all.

• If A is on, the track will be played unattenuated as long as the crossfader is in
the left half of its value range. As the crossfader moves toward the right across
the center position, the track fades out. At the crossfader’s rightmost position,
the track is muted.

• Likewise, if B is on, the track’s volume will be affected only as the crossfader
moves left across its center position.

The crossfade assign section is treated like one control with respect to MIDI mapping;
please see the MIDI mapping section for details (see MIDI Implementation).

It is important to understand that the crossfader assign switches do not affect the
signal routing: the crossfader merely influences the signal volume at each track’s gain
stage. The track can be routed to an individual output bus regardless of its crossfade
assignment. In studio parlance, you can think of the crossfader as an on-the-fly VCA
group.

As almost everything in Live, your crossfading maneuvers can be recorded into the
arrangement, for later in-depth editing. To edit each track’s crossfade assignment,
please choose “Mixer” from the top envelope chooser pop-up menu, and “X-Fade Assign”
from the bottom menu. The crossfader’s automation curve is accessible when “Mixer” is
chosen from the Master track’s top envelope chooser pop-up, and “Crossfade” is selected
from the bottom menu.
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1.5.3 Using the Live Effects

Effects in the Track View.

Every track in Live can host an unlimited number of Live effects. The Track View is
where you insert, view, and adjust the effects for the selected track. To select a track
and open the Track View to access its effects, double-click the track’s name. The Track
View appears in the bottom area of the Live screen.

The Live Effects Chooser.

Now, click on the Live Effects chooser in the browser area to access the palette of Live’s
built-in effects. To place one instance of the effect in the track, pick the desired effect
and drag it into the Track View. Play with the effect’s controls to change the sound. To
learn what an effect does and how to operate it, consult the Effect Reference section
(see The Live Effects).

To add another effect to the track, simply drag it there, or double-click its name to
append it to the end of the effect chain. Audio travels from left to right on the track,
and you can drop effects in at any point.

To remove an effect from the chain, click on the name and either press your computer’s
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Delete or Backspace key, or select Delete from the Edit menu. To change the order of
effects, drag an effect by its name and drop it between any of the other effects in the
Track View; or, drag it onto another track in the mixer to place the effect in that track.
Generally, effects can be placed, re-ordered and deleted without interrupting the audio
stream.

The Effect Active Switch.

Effects can be turned on and off using their activator switch. Turning an effect off is like
temporarily deleting it: audio remains unprocessed, and the effect does not consume
CPU cycles. Live effects generally do not load down the CPU unless they are active. For
more information, please refer to the CPU load section (see Managing the CPU Load).

Every Live effect can store and retrieve particular sets of parameter values as Presets.
Two buttons for managing the effect presets are located on the top right of each effect.

A Preset Recall Button.

To audition presets for possible selection, click once on the Preset Recall Button to make
the preset pop-up appear. Use the arrow up and down keys to go through the existing
presets while listening to how they sound, and watching the effect settings change. To
select a preset by name, click on the pop-up to open it. The available presets will be
listed, and sorted alphabetically:

• The Factory Settings is the effect’s default state when it is inserted from the
effects browser. This preset is always at the top of the list.

• Below the factory settings are the Factory Presets, which are installed with the
program. These presets are updated as new versions of Live become available.
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• The User Presets are listed below the factory presets. You can create any number
of user presets, which are not bound to a particular instance of the effect, or to
the current Live Set. They will be available in any other instance of the effect
and any other Live Set as well.

The Preset Save Button.

The Preset Save Button is for saving, overwriting, and deleting user presets. Clicking on
this button opens a dialog window.

The preset save / delete
dialog

To overwrite an existing user preset, select it from the list of user presets and click the
Overwrite button.

To save a user preset, type a preset name into the text edit field and click the Save
button. If a preset with that name already exists, you will be asked if you want to
overwrite that preset. If not, choose a different name and try again. Otherwise, click
on “ok” to overwrite.

To delete a user preset, select it and click the Delete button.
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To leave the preset dialog, choose Close.

Each preset is stored as a normal, stand-alone file in the “UserPresets” folder beneath
the Live Preferences folder. This makes it easy to back up or copy presets to another
computer. The UserPresets are located in:

• Mac OS 9 System Folder:Application Support:Ableton:Live

• Mac OS X [Home]/Library/Application Support/Ableton/Live

• Windows [YourProgramsFolder]/Ableton/Live

1.5.4 Send Tracks and the Master Track

So far, we have worked with tracks that play clips. Live also has send tracks and a master
track; these cannot play clips, but allow for more flexible signal processing and routing.

The send tracks and the master track occupy the right hand side of the Session mixer
view and the bottom end of the Arranger View. Note that you can hide and show the
send tracks using the Sends command in the View menu (see The View Menu).

Like the “normal” clip tracks, the sends and the master can host any number of effects.
However, whereas a clip track’s effect processes only the audio within that track, send
tracks can process audio sent to it from numerous tracks.

For example, suppose you want to create rhythmic echoes with a delay effect. If you
drag the effect into a clip track, only clips playing in this track will be echoed. Placing
this effect in a send track lets it receive audio from any number of tracks, and add
echoes to them.
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The send controls in the
Session mixer (left) and in
the Arranger mixer (right).

A clip track’s send control regulates how much of the clip track’s output feeds the
associated send track’s input. What’s more, even the send track’s own output can be
routed to its input, allowing you to create feedback. Please use this feature with care,
as runaway feedback can boost the level dramatically and unexpectedly.

The master track is the default destination for the signals from all other tracks. Drag
effects here to process the mixed signal before it goes to the master output. Effects
in the master track usually provide mastering-related functions, such as compression
and/or EQ.

You can create multiple send tracks using the Insert Send Track menu command (see
Insert Send Track), but by definition, there is only one master track.

1.5.5 MIDI-mapping Mixer and Effect Controls

You can get more “hands-on” with your project by assigning a MIDI control box’s knobs
and switches to Live’s mixer and effect controls, which often provides a more satisfying
experience compared to using a mouse.

The MIDI Map Mode Switch.

Click on the Control Bar’s MIDI switch, or use the Option menu’s Edit MIDI Map command
(see Edit MIDI Map) to enter MIDI map mode. In this mode, you can click on any mixer
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or effect control, then assign it to a controller simply by sending the desired MIDI
message (for example, by turning a knob on your MIDI control box). Your assignments
take effect immediately after leaving MIDI map mode.

The Key Map Mode Switch.

Switches, buttons, and radio buttons can be mapped to the computer keyboard keys as
well. To make an assignment, click on the Control Bar’s KEY switch, or use the Option
menu’s Edit Key Map command.

For details about Live’s MIDI implementation, please refer to the MIDI mapping section
(see MIDI Implementation).

1.5.6 Using VST Plug-ins

Working with VST Plug-ins is very much like working with Live Effects. Before Live can
access any VST Plug-ins, it needs to be told about the location of the VST Plug-in folder
containing the effects you want to use. To do that, go the Misc Preferences via the
Options menu. Under the Misc tab you will find the VST Plug-in Folder entry. Click the
Browse button to open a folder search dialog and locate, then select, the appropriate
folder. The VST Plug-ins Browser will then display all plug-ins it finds in the VST Plug-in
folder, as well as any subfolders.
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A VST Plug-in in the Track
View.

In the Track View, the original VST Plug-in panel graphics will be replaced with a Live
panel; all VST Plug-in parameters are represented in the Live panel and work in the
same way. You can, for instance, map an arbitrary MIDI-controller message to every VST
Plug-in parameter (see MIDI Implementation).

The Plug-In Unfold Button,
next to the Active Switch.

You can view or hide the VST Plug-in’s parameters by toggling the triangle-shaped
button in the plug-in’s title bar.

The Plug-In Edit Button.

The Edit button opens a floating window that shows the original VST Plug-in panel.
Changing parameters on the floating window has the same effect as changing them in
the Live panel, and vice-versa.

The Plug-In Preset Pop-Up.

You can access any presets that the VST Plug-in may have by using the pop-up menu to
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the right of the Edit button.

To assign any two plug-in parameters to the Live panel X-Y window, use the drop-down
menus directly beneath it.

1.5.7 Recording Automation

Often, when working with Live’s mixer and effects, you will want the controls’ move-
ments to become part of the music. The movement of a control across the song timeline
is called automation; a control whose value changes in the course of this timeline is
automated. Practically all mixer and effect controls in Live can be automated, including
the song tempo.

Creating automation is straightforward: all changes of a control that occur while the
Control Bar’s Record switch is on become automation. Try recording automation for a
control, for instance a mixer volume slider. After recording, play back what you have
just recorded to see and hear the effect of the control movement. You will notice a little
red “LED” has appeared in the slider thumb to indicate the control is now automated.
Try recording automation for track panning and the track active switch as well; their
automation LED appears in the upper left corner.

The volume, pan, and track
active switch have been
automated.

To delete automation data, simply select an automated control (by clicking on it) and
choose the Edit menu’s Delete Automation (see Delete Automation) command. The
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automation LED disappears, and the control’s value stays constant across the entire
song.

In practice, you will often want to try out new control moves without overwriting
existing automation data. Well, nothing is forever in the world of infinite Undo (see
Undo), but it’s easy to disable a control’s automation temporarily to avoid overwriting
existing data: when you change an automated control’s value while not in Record
mode, the automation LED goes off to indicate the control’s automation is inactive. Any
automation is therefore overridden by the current manual setting.

The Back to Arrangement
Button.

When one or more of the automated controls in your Live Set are not active, the Control
Bar’s Back to Arrangement Button lights up. This button serves two purposes:

1. it reminds you that the current state of the controls differs from the state captured
in the Arrangement;

2. you can click on it to re-activate all automation and thereby return to the au-
tomation state as it is written “on tape.”

You can, of course, re-record a control movement over and over again until it is right.
It might be easier, however, to graphically edit the automation as a breakpoint envelope
in Live’s Arranger View (see Editing Automation Envelopes).
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1.6 Playing Session Clips

In the Arranger View, as in all traditional sequencing programs, everything happens
along a fixed song timeline. For a number of applications, this is a limiting paradigm:

• when playing live, or when DJing, the order of pieces, the length of each piece,
and the order of parts within each piece is generally not known in advance;

• in the theatre, sound has to react to what happens on stage;

• when working along with a piece of music or a film score, it can be more efficient
and inspirational to start with an improvisation, which is later refined into the
final product.

This is exactly what Live’s unique Session View is for.

In the topmost browser, double-click on “Live Demo Session.als”. The Session View
appears.

A playing clip in the session
view.

Each clip has a triangular button at the left edge. Click the button with the mouse
to “launch” clip playback at any time, or pre-select a clip by clicking on its name and
launch it using the computer’s Return or Enter key. You can then move on to the
neighboring clips using the arrow keys.

Clips can be played at any time and in any order. The layout of clips does not prede-
termine their temporal succession; the Session grid offers random access to the clips it
contains.
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Each track (column) can play only one clip at a time. It therefore makes sense to put a
set of clips that are supposed to be played alternatively in the same columns: parts of
a song; variations of a drum loop; etc.

A Session View Scene.

The horizontal rows are called Scenes. The Scene Buttons are located on the rightmost
column, which represents the Master Track (see Send Tracks and the Master Track). To
launch every clip in a row simultaneously, click on its associated scene button. This can
be very useful in organizing the live performance of a song with multiple parts.

A Slot Stop Button.

Click on a Stop Button to stop a running clip, either in one of the track’s slots, or in
the Track Status Field below the Session grid. Note that you can add and remove the
slot buttons using the respective Edit Menu commands (see Add / Remove Slot Button).
This is useful for pre-configuring the scene launch behavior: if, for instance, you don’t
want scene 3 to affect track 4, remove the scene 3 / track 4 slot button.

Clips can be moved around the Session Grid by drag-and-drop. To move several clips
at once, select them by using the Shift- or Control (PC) / Command (Mac)-modifier
before dragging. You can also click into an empty slot and “rubberband”-select from
there. Scenes can be reordered by drag-and-drop as well. There are a number of Edit
Menu commands (see The Edit Menu) that operate on the selected clips. Of course,
you can also drag new clips from the browser into the Session grid (see Browsing and
Pre-Listening).
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1.6.1 Mapping Clips to Computer Keys

The keys of the computer keyboard can be used to trigger clips and scenes.

The Key Map Mode Switch.

Click on the Control Bar’s KEY switch, or use the Option menu’s Edit Key Map command
(see Edit Key Map) to enter Key Map Mode. In this mode, you can click on any Session
View slot or scene, then assign it to a key simply by typing the key. Key-mapping is also
available for all the other Live controls that have a colored overlay in Key Map Mode.
Your assignments take effect immediately after leaving Key Map Mode.

1.6.2 Mapping Clips to MIDI Notes

Slots and scenes can be mapped to MIDI messages in MIDI Map Mode, which works much
the same as Key Map Mode. MIDI Map Mode is entered by clicking the Control Bar’s MIDI
switch, or using the Option menu’s Edit MIDI Map command (see Edit MIDI Map).

The Relative Session
Mapping Strip.

Notice that you can make not only absolute mappings to individual slots and scenes, but
also relative mappings to move the highlighted scene and operate on the highlighted
clips:

The Scene Up/Down
Buttons.
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Assign these buttons to keys, notes, or controllers to move the highlighted scene up
and down.

The Scene Scroll Control.

Assign the scene number value box to a MIDI controller, preferably with an endless
knob, to scroll through the scenes. For details, see the discussion of incremental map
modes (see Mapping to Incremental MIDI Controllers).

The Scene Launch Button.

Assign this button to launch the highlighted scene.

A Track Launch Button.

Assign these buttons to launch the clip at the highlighted scene, in the respective track.

Relative session mapping is useful for navigating a large Live Set, as Live always keeps
the highlighted scene at the Session view’s center.

For details on Live’s MIDI implementation, please see the respective section (see MIDI
Implementation).

1.6.3 Quantization and Launch Modes

Double-click on a clip to edit its properties in the Clip View. The leftmost Clip View
section lets you control how a clip triggers when it’s launched.
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The Clip Quantization
Pop-Up.

The Quantization pop-up menu lets you adjust an onset timing correction for clip trig-
gering. To disable clip quantization, choose “None”; to use the Control Bar’s global
quantization setting, choose “Global.”

The Clip Launch Mode
Pop-Up.

The Launch Mode pop-up offers a number of options for how clips behave with respect
to mouse clicks:

• Trigger: mouse down starts the clip; mouse up is ignored.

• Gate: mouse down starts the clip; mouse up stops the clip.

• Toggle: mouse down starts the clip; mouse up is ignored. The clip will stop on
the next mouse down.

• Repeat: As long as the mouse is held, the clip is triggered repeatedly at the clip
quantization rate.

These modes are available for playing clips with MIDI notes too; mouse switch-down is
the same as a MIDI note on, while mouse switch-up is equivalent to a MIDI note off.
Please note that the gate and repeat launch modes are not available when launching
clips from computer keyboard keys.
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1.6.4 The Track Status Fields

You can tell a track’s status by looking at the track status field just above the active
track’s mixer controls:

A track playing a looping
Session Clip. . .

The pie-chart icon represents a looping Session Clip. The number to the left of the circle
is the loop length in beats, and the number at the right represents how many times the
loop has been played since its launch.

. . . a One-shot Session
Clip. . .

The progress-bar icon represents a one-shot (non-looping) Session clip. The value dis-
plays the remaining playtime, in minutes:seconds.

. . . Monitoring the Input. . .

A microphone icon appears when the track’s Monitor switch is on.
. . . playing the
Arrangement.

If the track is playing clips from the Arrangement, a miniature display representing the
Arrangement clips being played appears.

The last option might puzzle you; let’s have a closer look at how Session and Arrange-
ment relate.
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1.6.5 Recording Sessions into the Arrangement

The Control Bar’s Record
Switch.

When the global record button is on, Live logs all of your actions into the Arrangement:

• the clips launched;

• changes of those clips’ properties (see Setting Clip Properties);

• changes of the mixer and the effects’ controls, also known as automation (see
Recording Automation).

To finish recording, press the Record button again, or stop playback.

The Arranger Chooser

To view the results of your recording, bring up the Arranger View. As you can see,
Live has copied the clips you launched during recording into the arrangement, on the
appropriate tracks and the correct song positions. Notice that your recording has not
created new audio data, only clips. As clips merely reference the samples on disk, you
don’t have to worry about disk space when recording Session clips.

The Session clips and the Arrangement clips in one track are mutually exclusive: only
one can play at a time. When a Session Clip is launched, Live stops playing back
the Arrangement in favor of the Session clip. Clicking a slot Stop button causes the
Arrangement playback to stop, which produces silence.

The Back to Arrangement
Button.
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Arrangement playback does not resume until you explicitly tell Live to resume by clicking
the “Back to Arrangement” button, which lights up to remind you that what you hear
differs from the Arrangement.

The Stop All Clips Button.

To disable all Arrangement clips simultaneously, click on the Stop All Clips button in the
Master Track’s status field.

The clips in the Arrangement and in the Session View exist independently from one
another, which makes it easy to improvise into the arrangement over abd over again,
until it’s right.

Furthermore, you can move clips not only within the Session grid, but also from the
Session View to the Arranger and vice versa using Copy and Paste, or by dragging clips

over the or choosers.

When pasting material from the Arranger into the Session View, Live attempts to pre-
serve the temporal structure of the clips by laying them out in a matching top-to-bottom
order. Moving through the scenes from the top down, you can reconstruct the original
arrangement. This is useful for taking a composed piece of music back to the improvi-
sational stage.
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1.7 Recording Audio

1.7.1 Related Preference Settings

Audio recording requires several preferences to be set up properly. Usually, these things
are set up once for a given hardware setup. Live needs to know:

• The audio driver model in use (see Device Type);

• The audio input device (see Input Device);

• The input buffer size (see Input Buffer Size/Input Latency) which relates to la-
tency (see Managing Audio Latencies);

• Whether you are monitoring audio signals through Live (see Monitor Input).

It can save time by setting up reasonable defaults for the clips you are recording (see
Clip Defaults). In particular, it is smart to indicate the rough category of sound to be
recorded by choosing the appropriate default Warp Mode. May you decide later on a
different song tempo, the program will automatically maintain good sound quality (see
Adjusting for Good Stretching Quality), usually without further adjustment.

1.7.2 Recording in Sync

Live keeps the audio you have recorded in sync, even when you later decide on a
different song tempo. In fact, Live allows you to change the tempo at any time, before,
after and even during recording. You could, for instance, cheat a bit by turning down
the tempo to record a technically difficult part, and pull it up again afterwards.



1.7. RECORDING AUDIO 46

It is important to record in sync to make sure everything will later play in sync.

The Metronome Switch.

The easiest way to record in sync is to set up a simple drum loop to play along with or
to use the built-in metronome, which is activated via its Control Bar switch.

The Metronome / Pre-listen
Volume Control.

To adjust the metronome volume, use the mixer’s pre-listen volume control.

Notice that Live’s metrical interpretation of the audio being played can be edited, at
any time, using the Warp Markers (see Setting Warp Markers). Warp Markers can be
used to fix timing errors, and to change the groove or feel of your recordings. Using
Warp Markers, you can fix things in your recordings that otherwise require complicated
editing, or could not be done at all.

1.7.3 Choosing an Audio Input

Let’s select which signal to record; this happens in the Live Mixer (see Mixing and
Effects). The Input Type and Channel pop-up menus are available for each track, both
in the Arranger and Session mixers.

The Input Type, Input
Channel, and Output
pop-ups.
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The upper/left menu selects the input type or category:

• Live In represents the audio hardware’s physical inputs.

• Master Out is for re-recording Live’s own mixed output.

• All ReWire slave programs you have installed on your computer appear in the
Input Type menu, and are available as audio sources for Live. Please refer to the
ReWire section for details (see Connecting via ReWire).

The middle menu selects one of the input source channels, as chosen from the In-
put Type menu. In the “Live In” case, this setting selects your multi-channel audio
hardware’s inputs.

The Bus View Chooser.

The available input channels are displayed in the Bus View’s Input tab. You can adjust
a digital gain factor for each input, and use the Link switch to set up inputs as stereo
pairs.

The Bus View displays all
available input channels,
with gain and mono/stereo
selectors.
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1.7.4 Monitoring

Our next step will be to activate the Monitor and/or Arm switches in the mixer (see
Mixing and Effects).

A Track Monitor Switch.

If monitoring is on, you will hear the input signal that has been chosen for a track at
the track’s output, processed through the track’s effects. The track’s meter displays the
track’s input signal instead of the output when the Monitor and/or the Arm switch is
on.

1.7.5 Tape-style Recording

Tape-style recording happens
in the Arranger View.

Recording into the Arrangement is straightforward:

A Track Arm Switch.

If the Arm switch is on, the track is record-enabled. Of course, you can arm several
tracks at the same time for multi-track recording.

The Control Bar’s Record
Switch.

If the track is armed for recording, recording will start upon activating the Control Bar’s
Record switch and start playback.
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Note that you can toggle playback, recording, and the track arm switches independently
from one another. Using Key Map Mode (see Mapping Clips to Computer Keys) and MIDI
Map Mode (see MIDI Implementation) you can operate Live’s recording functions without
using the mouse, by assigning the Record, Play, Stop, and Arm buttons.

Loop Recording

The Song Loop Switch.

When you are recording into the song loop (see The Song Loop), Live retains the audio
recorded during each pass. You can later “unroll” the loop, either by repeatedly undoing
(see Undo), or graphically, in the Clip View: after loop recording, double-click on the
new clip. In the Clip View’s sample display, you can see a long sample containing
all audio recorded during the loop recording process. The Clip View’s loop marker (see
Setting Clip Properties) defines the start of the audio taken in the last pass; moving the
loop marker left lets you audition the audio from previous passes.

Using Punch Points

Suppose you just recorded the solo of your life - except for one section, which you
would really like to replace. Use the punch points to mark the section to be recorded
over; everything else is left untouched.

The Punch-In Switch.



1.7. RECORDING AUDIO 50

To prevent recording prior to the punch-in point, activate the punch-in switch. The
punch-in point is identical to the song loop’s start position.

The Punch-Out Switch.

To prevent recording after the punch-out point, activate the punch-out switch. The
punch-out point is identical to the song loop’s end position.

1.7.6 Live Recording

Live recording happens in
the Session View.

Live allows you to record new samples during a live jam, without stopping the music.
This happens in the Session View. Make sure the View menu’s “Clips” option is checked.

On the track in which you want to record, choose the audio input type and channel;
activate track monitoring if desired.

The Quantization Pop-Up.

Choose a quantization setting other than “None” to record perfectly-cut samples.

A Slot Record Button.

As you activate the track’s arm switch, you can see record buttons appear in the track’s
empty Session View slots. Clicking on any one of these record buttons will start record-
ing.
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A Session Clip being
recorded.

You will see a new clip appear in the slot. There are now two options:

1. Launch the new clip to jump from recording into loop playback without any in-
terruption;

2. or, click on any slot stop button to stop recording without switching to playback.

Using Key Map Mode (see Mapping Clips to Computer Keys) and MIDI Map Mode (see
MIDI Implementation) you can easily prepare mappings for live recording that do not
require using the mouse. One convenient setup uses only two keys on the computer
keyboard to navigate the Session View and initiate recording:

The Scene Up/Down
Buttons.

One key is used to jump to the next scene. . .

A Track Launch Button.

. . . and another key to start and end recording in the respective track. Live recording is
available in a multi-track scenario as well, as you could use the scenes to launch many
recordings at the same time. Again, it can be useful to preconfigure which tracks will
record new clips in what scenes by adding and removing the slot buttons (see Add /
Remove Slot Button).
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1.7.7 Locating Recorded Samples

Audio recording in Live creates new samples that are stored in the “Sounds” folder, a
disk location specific to the Live Set in which you are working. Please see the section
on managing samples (see Managing Samples).

1.8 Setting Clip Properties

Live’s power as a sound-design tool results from its ability to play a sample, although
static by nature, in many different ways. You can create variation by adjusting the
properties of the clips in your Live Set, which will be covered in this section.

As for customizing clips for live use, please refer to the section “Quantization and
Launch Modes” (see Quantization and Launch Modes).

The Clip View.

The Clip View displays the properties of the selected clip.
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The Clip View Chooser.

The Clip View is opened by clicking on its chooser. Alternatively, double-clicking selects
a clip and opens the Clip View.

In the Session View, clicking on a track’s Status Field opens the Clip View for editing
the clip that is currently running in the track.

1.8.1 Warped versus Un-Warped Playback

The Warp Switch.

First, let’s talk about the Warp Switch. When off, Live plays the sample at its original,
“normal” tempo, irrespective of the current Live Set tempo. This is useful for samples
that have no inherent rhythmic structure: percussion hits, atmospheres, sound effects,
spoken word, and the like. Turn the Warp switch on to play rhythmically-structured
samples (such as sample loops, music recordings, complete music pieces, etc.) in sync
with the current song tempo.

The Control Bar’s Tempo
Control.

To verify this, note that a warped sample’s speed follows the tempo as you change
the Control Bar’s tempo control. However, for accurate warping, Live needs to know
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the sample’s metrical structure. For properly-prepared loops, tempo and duration are
calculated automatically; most of the time, this is usually accurate enough that the
sample is immediately ready for use in Live. For other samples, you will have to provide
some hints (see Setting Warp Markers).

1.8.2 Clip Loop / Region

To have the clip’s region played as a (potentially infinite) loop, turn on the Loop switch.
Activating the loop also activates warping; unwarped clips cannot be played as loops.

The Clip Loop Switch.

You can adjust the loop, or region, using the Loop Markers above the sample display.
Zooming and scrolling the Clip View’s sample display works just like in the Arranger
(see Arranger Navigation). Note that you can use the sample display itself for zoom-
scrolling. The Clip View chooser serves as a sample overview, with added zoom/scrolling
functionality.

To move the region or loop, click and drag it left or right. While working in the sample
display, you can also use the up and down arrow keys to move the region or loop through
the sample.

Changing the Region or Loop
End.
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To change the region or loop start and end point, drag the left or right edge.

The Offset Marker.

The Offset Marker is visible only if the clip is set to loop. It represents the point in the
sample where the clip starts playing. To adjust this, drag the offset marker left or right.
You may have noticed that, as you move the clip loop, the offset marker jumps so that
it stays within the loop. If the loop size is set to one, two, four, eight, etc. bars, any
jump remains locked to the rhythm, allowing you to play with the loop in a musical way.

The loop or region can also be adjusted numerically using the respective value fields. For
warped clips, these fields display values as bars-beats-sixteenths; for unwarped clips,
the display is in minutes-seconds-milliseconds.

Remember that Clip View settings apply only to the selected clip; they don’t affect the
sample on disk. Any number of clips can play the same sample, as well as using different
settings.

1.8.3 Name and Color

The Clip Name Field.
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The name field allows for naming the clip. By default, a clip’s name matches the name of
the sample it references, but in general, the clip name is independent from the sample
name.

Renaming a clip does not rename the referenced sample. To rename a sample, select it
in the built-in file browser, then choose the Edit menu’s Rename command.

The Clip Color Pop-Up.

The color pop-up menu allows choosing a clip color.

1.8.4 Pitch, Gain and Quality

The Clip Transpose Control.

The Transpose control shifts the clip pitch in semitones.

The Clip Detune Control.

The Detune control fine-tunes the clip in cents (100 cents = one semitone).
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The Clip Gain Control.

The Gain control, calibrated in dB, changes the clip level.

The High-Quality Switch.

If the High-Quality Switch is on, Live uses an advanced sample-rate conversion algo-
rithm that provides better sound quality at the expense of a higher CPU load. Samples
processed with the Hi-Q algorithm generate less distortion, particularly at high frequen-
cies, when transposing a sample and/or matching an imported sample’s sampling rate to
the system’s sampling rate. Note: This feature involves only sample rate conversion, not
the time-stretching quality. There are dedicated controls for adjusting the stretching
properties (see Adjusting for Good Stretching Quality).

The Fade Switch.

The Fade Switch, when enabled, applies a short fade to the clip start and end to avoid
clicks at the clip edges. The length of the fade is signal-dependent, and ranges from
0-20 milliseconds. Live attempts to start a fade in, or a crossfade, early enough so that
there is no attack smearing at the clip start. Likewise, fadeouts are set up so that they
end with the clip end.
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1.8.5 Using the Sample-Related Commands

The Replace Sample Button.

The Sample Replace Button can replace the sample referenced by the clip with a different
sample. A file-chooser dialog appears to select the new sample. Live loads the new
sample while retaining the clip properties; the Warp Markers (see Setting Warp Markers)
are kept if the new sample has the same length as the old sample, and discarded
otherwise. This function is particularly useful to locate missing samples, which are
marked “offline” (see Offline and Lost Samples).

The Edit Sample Button.

The Edit Sample Button opens the sample in a sample editing application, as specified
in the Misc Preferences. To process a sample in an external program, you will have to
stop Live’s playback. Upon returning to Live, it will play back the edited version of the
sample. The current set of warp markers is retained only if the sample length is exactly
the same as before editing the sample. Remember that changes to one sample may
affect other clips playing the same sample.

The Save Default Clip
Button.

The Save Default Clip Button saves the current clip’s settings with the sample. Once
saved, Live will restore the current clip settings whenever you drop the sample into a
Live Set. This is especially useful with regards to the warp markers, which have to be
set correctly for Live to play long files in sync. Note that you can use the Save button
without affecting any existing clips; save just saves default settings for future clips



1.8. SETTING CLIP PROPERTIES 59

using this sample. The clip data becomes part of the analysis file (see Analysis Files
(.asd)) that accompanies the sample.

The Reset To Default Button.

The Reset To Default button restores the warp marker settings, as if the sample were
dragged into the Live Set again.

1.8.6 Setting Warp Markers

Live’s ability to play any audio sample in sync with a chosen tempo is a unique and
important feature. In addition, you can “warp” any sample’s rhythmic flow, which can
change the sample’s “feel” or even move notes to other meter positions.

Think of a sample as a rubber band that you want to pin to a (musical time) ruler. In
Live, the pins are called Warp Markers. A warp marker forces the software to arrive at a
specific point in the sample at a specific musical time. You can use any number of Warp
Markers to create an arbitrary mapping of the sample’s inherent rhythm to a musical
meter.

In the following, we will look at a couple of applications.

Syncing Straight Loops

When you import a sample that represents a well-cut musical loop of 1,2,4, or 8 bars
in length, Live usually makes the correct assumptions to play the loop in sync with the
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chosen tempo. It places two warp markers; one at the sample’s beginning and one at
the end.

A one-bar loop as it appears
in the Clip View, by default

The “Orig. Tempo” value box displays Live’s guess of the loop’s tempo. Sometimes Live
guess of the original tempo is wrong by half, or double. If so, correct this by clicking on
the Buttons labeled *2 and /2, respectively. The sample plays at double speed when you
press /2 because you are changing Live’s interpretation of the sample’s tempo, which
serves as a point of reference for determining the required time-stretch factor.

Syncing Uncut Loops

When importing a loop that has not been edited into a well-cut loop, Live will play it
out of sync. Suppose there is a portion of silence at the sample beginning, prior to the
first beat. You can easily correct this by moving the warp marker labeled with a “1” to
the first beat’s onset. Likewise, you can eliminate silence after the actual loop end by
moving the Warp Marker at the sample’s right edge.
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Setting the warp markers for
a badly-cut loop.

Syncing Odd-Length Loops

If you import a sample that contains a seven bar loop, Live initially assumes the loop is
eight bars long (or four, depending on its length), and plays it out of sync. For correct
playback, the last marker needs to show a seven, not an eight. To do this:

1. double-click on the last warp marker to delete it;

2. double-click on the seven to create a new warp marker;

3. drag the new warp marker to the sample end.

If Live’s initial guess was a four-bar loop, the seven would not have been accessible. In
that case, you could initially drag the warp marker at the end toward the left, until the
seven becomes visible.

Theoretically this should have done the job for our seven bar loop. Practically, though,
it is very likely that moving the markers led to a change of the loop start and end
points. This is because the loop is tied to the meter grid and therefore moves with the



1.8. SETTING CLIP PROPERTIES 62

warp markers, which define the meter grid. Live makes sure the loop fits in the sample,
and therefore has to change its length if required by a warp marker change.

Manipulating Grooves

You can now create any number of warp markers by double-clicking on one of the gray
beat markers. Drag in a “straight” looped sample, set a few warp markers, and move
them around to see what happens. Warp markers really serve two purposes:

1. to provide a “correct” interpretation of the flow of musical time in the sample;

2. to mess up the flow of time in the sample.

If a single event in a percussion loop comes late, just pin it to the warp marker, which
shows the beat position at which you actually want to hear that event. You may want
to pin the adjacent beat positions as well, to avoid affecting neighboring regions in the
sample.

Using warp markers to
manipulate the groove.
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Syncing Longer Pieces

Once you are familiar with the basic concept of warping you are ready for a slightly more
complicated task: warping longer pieces.

• Drag a long sample into a Session View slot. When you drag in a sample that
is too long to justify the assumption that it contains a loop, Live will play the
sample “unwarped” by default. Double-click on the clip to view its properties in
the Clip View. Make sure the Warp switch is off.

• To get a reasonable initial tempo guess for the piece, we will use Live’s Tapping
facility (see Tapping the Tempo). Play the unwarped clip, with everything else
muted, and tap along with the beat for a bar or two. Tapping sets the Live Set’s
tempo without affecting the unwarped clip’s playback speed; tapping along with
the unwarped clip syncs Live to the sample’s original tempo.

• Now turn on the Warp switch. Note that the original tempo field shows the same
value as the Control Bar’s tempo field. Live has used the current song tempo as a
guess for the sample’s original tempo.

• Turn on the Clip View’s Loop switch.

• Initially, there is just one warp marker (labelled “1”). Drag that marker to where
you believe the first downbeat is. Start playback to test if your assumption
is right; if it is not, move the warp marker and try playing it again until you
find the first downbeat. Incidentally, you can zoom in and out around the loop
start (which now coincides with the warp marker we are moving) by pressing the
computer’s + and - keys.
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The first downbeat has been
identified.

• When you have found the downbeat, you are ready to match the tempo. Activate
the metronome. Alternatively, you could drop a simple loop into another track
and play along with that.

• Set the loop length of the clip to be warped to 1, 2, or 4 bars; the easiest way to
do this is to type the value directly into the leftmost Length value field.

• While playing, drag one of the gray markers above the clip waveform horizontally
until the loop sounds in sync with the metronome or your reference loop. Once
this loop sounds right, advance the loop by one loop period. The easiest way to
do this is to press the arrow-up key while the sample is in focus.



1.8. SETTING CLIP PROPERTIES 65

Dragging the “2” marker to
match the sample’s tempo.

• Now, as you listen to the looping sample along with the metronome or your
reference loop, move the gray marker at the loop start to make sure it matches
with respect to the tempo. Use the + and - keys to zoom around the loop start.
Once it’s right, “pin” the gray marker at the loop start by double-clicking. You
have now created the second warp marker.

• Keep moving forward through the sample using the up arrow keys; for each con-
secutive loop position, adjust the gray marker at the loop start, and then pin it
by creating a warp marker. Repeat this procedure until you have reached the end
of the sample.

• Now your sample has one warp marker per loop period. With a little practice, you
will soon find it is not necessary to create a warp marker for every loop position.
If the sample’s tempo is stable, you may use longer loop lengths and set fewer
markers; if the tempo changes very often, you will likely want to use a one-bar
loop, and set a warp marker at every bar.

• Once you are done setting warp markers, don’t forget to turn off the Loop switch
and to set the region start and end correctly.



1.8. SETTING CLIP PROPERTIES 66

The result of setting warp
markers for the piece.

Of course, your warp markers will be saved with the Live Set. In addition, you probably
want to save them with the sample, so that they are reconstructed the next time you
drag the sample into Live. To do this, click the Clip View’s Save button (see Analysis
Files (.asd)).

If you frequently warp long pieces, you will learn to set warp markers very quickly.
Some Live users prefer different ways to warp, like “real-time warping”: you set the
warp markers in one go, while the complete piece is running unlooped. We found that
the method described above allows for faster-than-real-time warping: you can “loop-
hop” through the sample at any speed desired. Loop-hopping can be an interesting
thing to do in the course of a performance, too!

1.8.7 Adjusting for Good Stretching Quality

Live offers a number of time-stretching methods to accommodate all sorts of audio
material. The time-stretching method, and additional controls for each method, are set
up in the Clip View’s “Warp” box.
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The warp modes are different varieties of granular resynthesis techniques. Granular
resynthesis achieves time compression and expansion by repeating, and skipping over,
parts of the sample (the “grains”). The warp modes differ by the selection of grains, as
well as by the details of overlapping and crossfading between grains.

Let’s investigate which warp modes work best for different types of signals, and how
to adjust the warping controls for “clean” stretching. It’s also fun to “abuse” these
controls to achieve interesting artifacts instead of correct stretching.

• Beats mode works best for samples where rhythm is predominate (e.g., drum
loops as well as most pieces of electronic dance music). The granulation process
is optimized to preserve transients (attacks, note onsets) in the audio material.

Use the Transients control to guide Live’s assumptions about where to find tran-
sients in the sample. If there is no rhythmical activity at odd 16th notes, choose
8th, etc. For some interesting rhythmic artifacts, choose large transient values in
conjunction with pitch transposition.

• Tones mode serves well for stretching samples with a more or less clear pitch
structure, such as vocals, monophonic instruments, and bass lines.

Grain Size provides rough control over the average grain size used. The actual
grain size is determined in a signal-dependent way. For signals with a clear sense
of pitch contour, a small grain size work best. Larger grain sizes help avoid
artifacts that can occur when the pitch contour is unclear, but the tradeoff can
be audible repetitions.

• Texture works well for complex sound textures with an ambiguous pitch contour
(e.g., polyphonic orchestral music, all sorts of noise, atmospheric pads, etc.). It
also offers rich potential for manipulating all kinds of sounds in a creative way.
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The Grain Size control determines the grain size used; unlike in Tones mode,
this is a setting that Live will use unaltered, without factoring in the signal’s
characteristics.

Fluctuation introduces randomness into the process. Larger values give more ran-
domness.

• In Re-Pitch mode, Live doesn’t really time-stretch or compress the sample; instead,
it adjusts the sample playback rate to create the desired amount of stretching. In
other words, to speed up the sample by a factor of 2, it’s transposed up an octave.
This is like the “DJ stretching method” of using variable-speed turntables to sync
two records, or what happens to samples in samplers when they’re transposed.

The Transpose and Detune controls have no effect in Re-Pitch mode.

1.9 Exporting Audio (Render to Disk)

The File Menu’s Render to Disk command allows exporting Live’s Master audio output as
a new sample.

1.9.1 What signal will be rendered?

Render to Disk will always render the signal at Live’s Master output. If you are mon-
itoring the Master output, you can be sure that the rendered file will contain exactly
what you hear. To export individual tracks, deactivate all other tracks other than the
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ones you want to export by turning off their Track Activator switches (see Mixing and
Effects) in the mixer.

When Render to Disk is invoked while the Arranger View is up, Live will render the
selected time range. If you would like to render the current Arrangement loop, choose
the Select Loop command (see Select Loop) from the Edit menu prior to choosing Render
to Disk. Keep in mind that the selection of tracks is irrelevant: the signal to be rendered
is the Master output.

If you choose Render to Disk while the Session View is up, Live will ask you to specify
the length of the sample to be rendered. The Render to Disk dialog will come up with
a Bars:Beats:Sixteenths field where you can type in the length. Live will capture audio
from the Master output starting at the current play start position, for whatever duration
you specified.
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1.9.2 Rendering Options

The Render dialog.

The Render to Disk command opens a dialog that offers several rendering options:

• Normalize. If activated, the sample resulting from the render process will be
normalized (i.e., the file will be amplified so that the highest peak attains the
maximum available headroom).

• Render as Loop. If activated, Live will create a sample that can be used as a
loop. For example, suppose your Live Set uses a delay effect. If Render as Loop
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is on, Live will go through the rendering process twice: the first pass will not
actually write samples to disk, but add the specified delay effect. As the second
pass starts writing audio to disk, it will include the delay "tail" resulting from the
first pass.

• File Type, Bit Depth, Sample Rate. These options specify the type of sample to be
created.

• Create Analysis File. If activated, Live will create an .asd file that contains anal-
ysis information about the rendered sample. If you intend to use the new sample
in Live, check this option.

• Convert to Mono. If activated, Live will create a mono file instead of a stereo file.

1.10 Connecting via ReWire

Live supports the ReWire interface for connecting with another ReWire-compatible audio
program running on the same computer. This is useful if you want to use virtual or
hardware MIDI instruments with Live, as Live is dedicated to audio sequencing.

The ReWire technology, developed by Propellerhead Software, provides ReWire-compatible
programs with:

• common access to the audio hardware;

• shared transport functionality;

• synchronization to audio word clock and song positioning;
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• exchange of audio streams.

The programs in a ReWire connection play distinct roles: the ReWire Master accesses the
audio hardware and provides mixing facilities; the ReWire Slaves have no direct link to
the audio hardware, but instead send their audio output into the Master’s mixer.

Common ReWire master applications are Digidesign Pro Tools, Steinberg Cubase and
Nuendo, Emagic Logic Audio, MOTU Digital Performer, Cakewalk Sonar, and Cycling 74
Max/MSP. Common ReWire slave applications are Propellerheads Rebirth, Propellerheads
Reason, Arturia Storm, and Cycling 74 Max/MSP. Live can act as both a ReWire master
and slave.

Note that the ReWire protocol itself does not consume much CPU power. However, as
expected, running two audio-intensive programs on the same computer requires more
resources than running a single program.

1.10.1 Running Live in ReWire Master Mode

Connecting Live to a ReWire slave program is straightforward:

1. start up Live first;

2. when Live is up, start the slave program;

3. to pipe audio from the ReWire slave program into one of Live’s mixer tracks, select
the slave program from the Input Device pop-up (see Choosing an Audio Input);

4. choose one of the slave program’s output channels from the Input Channel menu
below the Input Type menu; Live displays the inputs as stereo pairs as well as
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individual mono channels.

5. activate track monitoring.

You should now hear the slave program’s audio output through Live. You can use the
Live Effects or VST Plug-ins to process the slave program’s audio, and record it into
Live. You can use both Live’s and the slave program’s transport controls to start and
stop playback, and to set the song position and tempo.

Make sure you quit the slave program before quitting Live.

1.10.2 Running Live in ReWire Slave Mode

Live will run in ReWire slave mode if it detects a running ReWire master application at
startup time. Therefore, always start the ReWire master application first, then start Live.
Likewise, you will first have to quit Live, then the ReWire master application.

Live’s operation in ReWire slave mode differs from the usual operation in some regards:

• Live will not have direct access to the audio interfaces; audio input / output is
handled by the ReWire master application. No audio input will be available to
Live.

• The sample rate is determined by the host application rather than by Live.

• External synchronization will be disabled (synchronize to the ReWire master ap-
plication instead). Live will not send sync or controller messages to the MIDI
output. Controlling Live via MIDI is still possible.
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• Live will not act as a ReWire master application. For instance, you cannot run
Rebirth as a ReWire slave of Live while Live is running as a ReWire slave of Cubase.
You can, however, run both Live and Rebirth as ReWire slaves of Cubase at the
same time.

1.10.3 More on ReWire

You can find up-to-date information on ReWire-related issues at the ableton FAQ web
site. Might you encounter ReWire related problems, this is the place to go first. If you
cannot seem to find an answer there, please contact the support team.

1.11 Computer Audio Issues

Real-time audio processing is a demanding task for general-purpose computers, which
were likely designed to run spreadsheets and surf the internet. An application like Live
requires a powerful CPU and a fast hard disk. This section will provide some insight on
these issues, and should help you avoid and solve problems with running audio on a
computer.

1.11.1 Managing the CPU Load

To output a continuous stream of sound through the audio hardware, Live has to per-
form a huge number of calculations every second. If the processor can’t keep up with

http://www.ableton.com/index.php?main=faq
http://www.ableton.com/index.php?main=faq
http://www.ableton.com/index.php?main=support-contact
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what needs to be calculated, the audio will have gaps or clicks. Factors that affect
computational speed include the processor’s clock rate (e.g., speed in MHz or GHz),
architecture, memory cache performance (how efficiently the processor can grab data
from memory), and system bus bandwidth - the computer’s “pipeline” through which all
data must pass. For this reason, many people involved with pro audio use computers
that are optimized for musical applications.

The CPU Load Meter.

The Control Bar’s CPU meter displays how much of the processor’s computational poten-
tial is currently being used. For example, if the displayed percentage is 10 percent, the
computer is just loafing along. If the percentage is 100 percent, the processor is being
maxed out - it’s likely that you will hear gaps, clicks, or other audio problems. Note
that the CPU meter takes into account only the load from processing audio, not other
tasks the computer performs (e.g., managing Live’s user interface).

Audio calculations have the highest priority in Live. Therefore, even if the CPU shows
a high percentage of processor usage, the audio stream should remain uninterrupted.
However, non-critical functions (such as screen redraws) might slow down because these
tasks are handled only when the audio processing “lightens up” a bit.

CPU Load from Multichannel Audio

One source of constant CPU drain is the process of moving data to and from the audio
hardware. For some audio hardware drivers, this drain can be minimized by disabling any
inputs and outputs that are not required in a project. In those cases, there are buttons
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in the Audio Preferences to access the Input and Output Configuration (see Hardware
Setup) dialogs, which allow activating or de-activating individual ins and outs.

Live does not automatically disable unused busses, because the audio hardware drivers
usually produce an audible "hiccup" when there is a request for an audio configuration
change. Therefore, Live offers only the enabled inputs and outputs in the mixer’s bus
selection pop-up menus (see Recording Audio). As these are already “reserved for use”.
you can choose among them while audio is running, without any glitching.

CPU Load from Tracks and Effects

Generally, every track and effect being used in Live incurs some amount of CPU load.
However, Live is “smart” and avoids wasting CPU cycles on tracks and effects that don’t
contribute anything useful.

For example, dragging effects into a Live Set which is not running does not significantly
increase the CPU load. The load increases only as you start playing clips, or feed audio
into the effects. When there is no incoming audio, the effects are de-activated until
they’re needed again (if the effect produces a “tail,” like reverb and delays, de-activation
occurs only after all calculations are complete).

While this scheme is very effective at reducing the average CPU load of a Live Set, it
cannot reduce the peak load. To make sure your Live Set plays back continuously, even
under the most intense conditions, play back a clip in every track simultaneously, with
all effects enabled.



1.11. COMPUTER AUDIO ISSUES 77

1.11.2 Managing the Disk Load

A hard drive’s access speed (which is related to, but not identical to, rotational speed)
can limit Live’s performance. Most audio-optimized computers use 7200 RPM or faster
drives. Laptops, to save power, often use 5400 RPM or slower drives, which is why
projects on laptops usually have lower track counts. The amount of disk traffic Live
generates is roughly proportional to the number of audio channels being written or read
simultaneously. A track playing a stereo sample causes more disk traffic than a track
playing a mono sample.

The Disk Overload Indicator.

The Disk Overload Indicator flashes when the disk was unable to read or write audio
quickly enough. When recording, this condition causes a gap in the recorded sample;
when playing back, you will hear dropouts.

To avoid disk overload:

• reduce the amount of audio channels being written by choosing mono inputs
instead of stereo inputs, using the Link button in the Bus View (see Recording
Audio).

• reduce the number of audio channels playing by using mono samples instead of
stereo samples when possible. You can convert stereo samples to mono using any
standard digital audio editing program, which can be called up from within Live
(see Using the Sample-Related Commands).

On Mac OS 9, you can increase the track count by creating a “RAM-Disk” using the
Memory control panel. Files placed in the RAM-Disk are read straight from RAM and
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not the hard disk. Naturally, the amount of audio data cannot exceed the RAM-disk’s
available RAM.

1.11.3 Managing Audio Latencies

The term Latency refers to the time it takes for sound from the inputs to become
available to the software, and for sound generated, or processed, by the software to
arrive at the audio outputs.

Latency is an undesirable, yet unavoidable fact of processing audio on a standard com-
puter. All audio software reads and writes audio in chunks, which are collected in
buffers. This is done for two reasons:

• to reduce the CPU load;

• to have a “reservoir” of incoming or outgoing audio available for those times
when the processor, even though audio is assigned the highest priority, must
attend to some other task.

The following methods help you to find suitable latency settings. These adjustments
have to be made only once for a given audio setup, and will be memorized by Live.
However, note that lower latencies add more stress to the CPU. In situations where
adding a few more plug-ins or tracks sends your system “over the edge,” increasing
latency a little bit may allow it to accommodate the extra load.

SoundManager (Mac OS 9’s native audio architecture) works with a preset latency setting
(512 audio samples).
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Adjusting the Output Latency

Minimizing output latency is important for getting a quick response from Live to your
actions, particularly when launching clips with the quantization turned off. After all,
when you launch a clip, you want it now — not later. Also, when monitoring audio
input through Live, the output latency contributes to the overall in-to-out delay and
should therefore be as low as possible.

The output latency is adjusted via Live’s Audio Preferences, either using the Output
Buffer Size control (see Output Buffer Size/Output Latency), or using controls offered
by the driver’s setup dialog (see Hardware Setup). Proceed as follows:

1. set the Output Buffer Size to its maximum value;

2. load a clip into any one of Live’s tracks, and play it. For testing purposes, use a
sustained sound rather than a sound that contains a lot of silence;

3. insert effects into the track that is playing your test clip until the CPU load (as
displayed in the Control Bar) reaches a level above 70 percent;

4. slowly reduce the Output Buffer Size until you can hear dropouts or clicks. Find a
value just high enough that the signal passes through undisturbed.

Adjusting the Input Latency

Reducing the input latency to the lowest workable value is important if you are moni-
toring live input sources through the program.
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The input latency is adjusted via Live’s Audio Preferences, either using the Input Buffer
Size control (see Input Buffer Size/Input Latency), or using controls offered by the
driver’s setup dialog (see Hardware Setup). Proceed as follows:

1. first, adjust the output buffer size as described above (see Adjusting the Output
Latency). Start from the setup described;

2. set the Output Buffer Size to its maximum value;

3. route an input signal into your test track, and activate monitoring on the track;
you should now hear the input signal being processed by the effects you have
inserted into the track;

4. slowly reduce the Input Buffer Size until you hear dropouts or clicks. Find a value
just high enough that the signal passes through undisturbed.

Adjusting the Overall Latency

The latency value reported to the software by the audio hardware drivers is not al-
ways completely accurate. The Overall Latency setting is a way to tell Live about any
deviations from the reported values.

This is important because when recording audio into Live the latency issue is critical.
Live has to move recorded samples in time with the song to compensate for any la-
tencies, and therefore requires precise information about the actual latencies in the
system.

We suggest the following procedure to determine the overall latency, which you will
have to go through only once for a given hardware setup:
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1. in the audio preferences, turn off the Monitor through Live switch;

2. drag an audio cable to short-circuit Live’s output to Live’s input. It does not
matter whether this is an analog or a digital connection; it is important, however,
that you use a “real” hardware connection;

3. choose a one-shot percussion sample that has a signal peak right at the sample
start, and drag this sample into track 1 of an otherwise empty arrangement. Make
sure the clip starts exactly at the song start;

4. set up track 2 for live audio in, such that it receives Live’s output signal;

5. arm track 2 and record a couple of seconds of audio;

6. now, track 2 contains an approximate copy of the clip in track 1, delayed by an
amount of time that corresponds to the overall latency;

7. double-click the new clip; in the Clip view, turn off the Warp switch;

8. move the region start marker to the right. In the Arranger display, you can
observe the percussion hit’s waveform in track 2 moving left. Keep moving right
until the percussion hit reaches the song start (zoom in if needed to get as close
a match as possible). You have now offset the region start of the clip in track 2
to compensate for the delay between the original and the copy;

9. from the Clip View’s Start value boxes, read out the value in milliseconds. Type
this value into the Audio Preference’s Global Latency field.

If desired, you can delete the recording from track 2 and repeat the test above to verify
that there is no offset between the original clip in track 1 and the recorded copy in
track 2.
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Monitoring and Latency

To make sure that the samples you are recording into Live will later play in sync,
Live compensates for the latencies involved. To do this correctly, it needs to know
whether you are monitoring live audio sources through the software, or through external
equipment (or not at all).

Therefore, make sure that the Monitor through Live (see Monitor Input) switch in the
Audio Preferences matches your actual monitoring setup.



Chapter 2

Live Reference

2.1 Live Preferences

The Preferences dialog contains several settings that control Live’s operation. To open
the Preferences dialog window, select “Preferences” from the Options menu. You can
access the Live main window at any time while the Preferences dialog is open. Prefer-
ences settings are saved with the application. Loading and saving Live Sets does not
affect the Preferences settings.

83
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2.1.1 Misc Preferences

The Misc(ellaneous) Preferences control various aspects of Live’s behavior and appear-
ance.

Clip Update Rate

The Clip Update Rate is the rate at which Live updates a running clip’s settings. Play a
clip from the Session View and open the Clip View to access the clip’s settings. If you
change any of the settings (Transposition, for instance), your changes are quantized by
the rate selected from the Clip Update Rate pop-up menu.

When you change a running Session View clip’s controls while the Control Bar’s Record
switch is on, Live creates copies of the clip at the selected Clip Update Rate and puts
them into the Arrangement. For details on recording sessions, refer to the relevant
section in the Guided Tour (see Recording Sessions into the Arrangement).

Create Analysis Files for Samples

Live analyzes every sample upon loading. The analysis data speeds up the waveform
display and improves the Time Warping Engine’s operation. When the Create Analysis
Files for Samples switch is turned on, the analysis results are stored in an analysis file.
Upon dragging this file into a Live Set, Live reads the analysis data from the analysis
file instead of running the analysis again.
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The analysis file resides in the same directory as its associated sample, and uses the
same name with an “.asd” extension. The analysis file is very small when compared to
the sample. However, if you want to prevent Live from filling your disk with .asd-files,
uncheck “Create Analysis Files for Samples." For more information on files used and
created by Live, refer to the “Managing Samples” section (see Managing Samples).

Record File Type

This specifies the type of sample files created by Live when recording new audio (see
Recording Audio). The sample rate is set by the output sample rate (see Sample Rate).

Record Bit Depth

This specifies the bit depth of sample files created by Live when recording new audio
(see Recording Audio). The sample rate is set by the output sample rate (see Sample
Rate).

Select on Launch

By default, clicking a Session View clip’s play button also selects the clip, since you will
typically want the Clip View to show the newly-launched clip. However, some power-
users don’t want the current focus (e.g., a Send Track’s effects) to disappear just because
a clip has been launched, especially when starting a clip in order to try it with the send
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effect settings. Turn off this preference if you prefer the view to remain as is when you
launch clips or scenes.

Load Skin

Selects among a set of “skins” (color schemes) for Live’s user interface.

Choose Language

Selects the system language. This also affects the Info View (see Getting Help from the
Info View) mouse-over help.

VST Plug-in Folder

Click to locate the folder containing VST Plug-ins. Live seeks VST Plug-ins in the selected
folder and displays the available ones in the Plug-in Effects Browser (see Using the Live
Effects). For more on working with VST Plug-ins, please see the respective section (see
Using VST Plug-ins).

Audio Record Folder

Click to select the Audio Record Folder. This is the disk location where Live will put
the samples you record into an unnamed Live Set. When the Live Set is saved, Live will
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attempt to move (space permitting) all samples from the temporary record folder to the
saved Live Set’s Sounds folder (see The Sounds Folder and Self-Containing).

Choose Sample Editor

Click to select a sample editor application that will open upon clicking the Clip View’s
Edit button (see Using the Sample-Related Commands).

2.1.2 Default Preferences

The Default Preferences determine the initial state of newly-created Live Sets and clips.

Save Template

Clicking will save the current Live Set as a template Live Set. Live will use these settings
as the initialized, default state for new Live Sets. You can use this to pre-configure:

• Your multi-channel input / output setup.

• Preset effects, like EQs and Compressors in every track.

• Computer key mapping.

• MIDI mappings.
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The template Live Set “Template.als” is located in Live’s Preferences folder, and can be
copied or deleted from there. The easiest way to locate this folder is to search your disk
for Template.als.

Clip Defaults

The controls in the Clip Defaults part of the Defaults tab specify the initial values for
clips that are created when dragging samples from disk into a Live Set.

The Loop/Warp pop-up menu selects the defaults for the Warp and for the Loop switch.
When “Auto” is chosen, Live makes educated guesses about what will create proper
warping, but these aren’t always right with complex or unusual material.

Auto-Assign Colors to Clips/Default Clip Color

Live will assign random colors to new clips if the Auto-Assign Colors to clips switch is
on. Otherwise, new clips are the color selected from the Default Clip Color pop-up menu.

2.1.3 Audio Preferences

The Audio Preferences settings manage audio input and output.
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Device Type

The Device Type pop-up menu chooses among the types of audio drivers available on
your computer. Live supports:

• SoundManager (under Mac OS 9)

• Core Audio (under Mac OS X)

• DirectX/MME (under Windows)

• ASIO (under Windows and Mac OS 9)

• Direct I/O (Digidesign’s proprietary audio architecture)

Whether several of the settings described below are present or not depends on the
chosen Device Type.

Windows only: Usually, ASIO drivers are the preferred choice because they allow for
lower latency times (see Managing Audio Latencies). ASIO drivers are available for
almost every professional audio I/O interface. Check with your audio hardware’s vendor
if you are unsure whether your interface supports ASIO.

Hardware Setup

Opens the driver’s control panel for driver-specific settings.
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Input Configuration

Brings up a dialog for enabling and disabling the individual stereo input pairs offered
by the chosen driver. Disabling the unused inputs saves CPU load (see CPU Load from
Multichannel Audio).

Output Configuration

Brings up a dialog for enabling and disabling the individual stereo output pairs offered
by the chosen driver. Disabling the unused outputs saves CPU load (see CPU Load from
Multichannel Audio).

Input Device

Use the Input Device pop-up menu to choose among the available audio input devices
that match the Device Type setting.

Input Buffer Size/Input Latency

The Input Buffer Size setting determines the delay between the time an audio signal
appears at the audio hardware’s inputs, and when it becomes available to the software.
This delay is called input latency. For further information on latencies, and on setting
up this preference, please see the Managing Latencies section (see Managing Audio
Latencies).
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If this control is missing, click the Hardware Setup button to access the device’s specific
setup dialog. For further information, please refer to your audio hardware’s documenta-
tion.

Monitor Input

Set this switch to inform Live about your recording setup. Here are the rules:

• If you connect your audio sources directly to Live, this switch must be on so you
can monitor the sources. A typical scenario would be recording a piece of music
from a record player into Live, with the preamp’s output connecting directly to
the computer’s input.

• If you monitor your audio sources through an outboard mixing console, or if you
do not monitor at all, the switch should be turned off. This would typically be
the case if you are singing or playing an instrument, or working with musicians
in a recording or stage environment.

• If your audio hardware offers “Zero-Latency-Monitoring”, and you are making use
of this option, this switch should also be turned off. For further information,
please refer to your audio hardware’s documentation.

When singing or playing instruments into Live, monitoring through the computer will
be acceptable only with low-latency (see Managing Audio Latencies) audio hardware
and associated drivers. An overall latency of a few milliseconds is not objectionable
(a latency of 3 ms delays audio by approximately the same amount as moving your
ears 1 meter further from a speaker), but latencies greater than 10-15 ms are definitely
annoying.
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Output Device

Use the Output Device pop-up menu to choose among the available audio output devices
that match the Device Type setting.

Output Buffer Size/Output Latency

The Output Buffer Size setting determines the delay between an audio signal being
generated in Live and the signal becoming available at the audio hardware’s outputs.
This delay is called output latency. For further information on latencies, and on setting
up this preference, see the Managing Latencies section (see Managing Audio Latencies).

If this control is missing, click the “Hardware Setup” button to access the device’s
specific setup dialog. For further information, please refer to your audio hardware’s
documentation.

Sample Rate

Use the Sample Rate setting to choose the sampling rate at which Live generates and
outputs audio.

Because Live performs a real-time sample-rate conversion, samples with arbitrary sam-
pling rates can be read, no matter which output Sample Rate you’ve selected. However,
the sampling rate of samples recorded in Live will always be identical to the output
Sample Rate.
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Depending on the selected Device Type, the sampling rate may be fixed (usually at
44,100 Hz).

Overall Latency

This setting is described in detail in the section on Adjusting the Overall Latency (see
Adjusting the Overall Latency).

Master

The Master pop-up menu selects an output bus for Live’s master track. The number of
available busses depends on the selected Output Device. The bus used for the Master
will not be available as a separate output destination for the tracks.

Pre-Listen

Selects the output bus to be used for pre-listening. The menu offers all available busses
except the bus that is used for the Master. If the chosen Output Device supports only
one stereo out, this menu and the Option menu’s PFL Switches entry (see PFL Switches)
will appear disabled.
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2.1.4 MIDI Preferences

MIDI Input Devices

The MIDI Input Device pop-up menus select the MIDI devices from which Live will
receive MIDI notes and controller messages. Live merges the MIDI coming in through
the two devices.

The MIDI In Indicator

When Live recognizes a MIDI message, the MIDI In Indicator next to the CPU Load meter
in the Control Bar flashes.

MIDI Output Device

This selects the MIDI device to which Live sends MIDI controller messages. This is useful
when working with external controller boxes that use endless knobs or motorized faders.
These devices need to be updated when a control’s value changes in Live, because the
position of the motorized faders or LED chains has to match the new value.

Send Control Updates Now

Sends the current state of all of Live’s controls. Use this to bring an external device up
to date after connecting it to the computer.
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Sync Input Device

The Sync Input Device pop-up menu selects the MIDI device from which Live receives
its MIDI sync messages.

The External Sync Switch.

Activate External Sync by switching on the EXT button in the Control Bar.

The External Sync Switch.

The External Sync Switch next to the EXT button flashes if Live receives useable sync
messages.

Sync Type

This chooses the type of sync messages to which Live will respond. The choices are:

• MIDI Clock. MIDI Clock works like a metronome ticking at a fast rate. The rate of
the incoming ticks is tempo-dependent: changing the tempo at the sync source
(e.g., a drum machine) will cause Live to follow the change. The MIDI Clock
protocol also provides messages that indicate the song position.

• MIDI Timecode. MIDI Timecode is the MIDI version of the SMPTE protocol, the
standard means to synchronize tape machines and computers in the audio and
film industry. A MIDI Timecode message specifies a time in seconds and frames
(subdivisions of a second). Live will interpret a time code message as a position
in the Arrangement. Timecode messages carry no meter-related information; when
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slaving Live to another sequencer using MIDI Timecode, you will have to adjust
the tempo manually. Tempo changes cannot be tracked.

When synchronising Live from an external sync source, the latency issue (see Manag-
ing Audio Latencies) becomes particularly relevant: Live’s output may sound delayed
compared to the sync source’s output. Live “knows” its output will arrive at the au-
dio interface delayed by the audio output latency. It will therefore pre-delay its clock
to compensate for the audio output latency. This may not suffice, however, for two
reasons:

• some audio interfaces add latency that Live cannot detect;

• it takes some time for the MIDI sync messages to reach Live.

The Latency Compensation control allows offsetting Live’s internal clock, so that Live
and the sync master will play together in sync. To adjust the Latency Compensation,
have both Live and the sync source play a rhythmical pattern with pronounced, percus-
sive sounds. While listening to the output from both the sync master and Live, adjust
the Latency Compensation control until both sounds are in perfect sync. Usually, you
will have to make this adjustment only once for any given studio setup.

MIDI Timecode Frame Rate

This setting is relevant only if “MIDI Timecode” is chosen from the Sync Type menu.

The MIDI Timecode Frame Rate pop-up menu selects the type of Timecode to which Live
will synchronize. All of the usual SMPTE frame rates are available. When the Frame
Rate is set to “SMPTE All”, Live auto-detects the time code format of incoming sync
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messages, and interprets the messages accordingly. Note that you can adjust the time
code format that is used for display in the Arrangement View: go to the Options Menu,
then access the Time Ruler Format sub-menu.

MIDI Timecode Start Offset

This setting is relevant only if “MIDI Timecode” is chosen from the Sync Type menu.

You can specify a SMPTE time offset using the MIDI Timecode control. Live interprets
this value as the Arrangement’s start time.

2.2 The Live Menu

2.2.1 The File Menu

New

. . . opens a new Live Set.

Open

. . . opens an existing Live Set. Live Sets can also be located using the built-in file
browsers, and opened from there by double-clicking.
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Close

. . . closes the Live Set which is currently open.

Save

. . . saves the current Live Set.

Save As

. . . saves the current Live Set under a different name and/or in a different directory
location.

Save a Copy

. . . saves a copy of the current Live Set with a new name and/or new location, but does
not replace the current Live Set. Useful for saving multiple versions of a Live Set.

Save Self-Contained

. . . saves the current Live Set, and copies all externally referenced samples into the
Live Set’s Sounds folder. For details, refer to the section on the Sounds folder and
self-containing. (see The Sounds Folder and Self-Containing).
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Render to Disk

. . . brings up the Render dialog for exporting your work as a new sample. (see Exporting
Audio (Render to Disk))

Quit

. . . quits the program.

2.2.2 The Edit Menu

Undo

. . . undoes the previous action, thereby restoring the state of the Live Set to what it
was previously. This command can be used repeatedly, as Live maintains a “history” of
the actions carried out on a Live Set. Use the Redo command (see Redo) to return to
the Live Set’s state prior to invoking Undo. Using Undo and Redo, you can freely move
back and forth in the Live Set’s edit history. Note, however, that after performing any
action other than Redo after Undo will make Live “forget” the undone edit steps.

Redo

The action that was last undone (see Undo) is redone.
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Cut

. . . removes the selected material. Cut material is placed on the clipboard and can be
pasted at any place within the same Live Set, or another Live Set. In the Arranger View,
Cut not only removes the clips, but also all automation in the selected time span, unless
the Lock Envelopes switch (see Editing Automation Envelopes) is on.

Cut Scenes

. . . cuts out scenes with selected slots from the Session View, thereby reducing the total
number of scenes. Please note that the Cut Scenes command affects all tracks, not only
those containing selected slots.

The Session View before and
after executing the Cut
Scenes command.

Cut Time

. . . cuts a selection of time from the Arrangement, thereby moving any audio on either
side of the cut area closer together in the timeline. This command reduces the length



2.2. THE LIVE MENU 101

of your Arrangement by whatever amount of time you have cut. Note that the Cut Time
command affects all tracks, not only the selected ones.

A gap between clips has
been deleted by first
selecting it, then executing
the Delete Time command.

Cut Envelope

. . . allows you to cut a selection of the breakpoint envelope currently displayed in the
track. The selected piece of the envelope is copied to the clipboard and can be pasted,
using the Paste command, anywhere in the same track or in another track. The envelope
breakpoints are removed from the original envelope selection.
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Cutting part of an envelope.
Notice the clip remains
unaffected.

Copy

. . . makes a copy of the selected material and places it on the clipboard. In the Arranger
View, Copy not only copies the clips, but also all automation in the selected time span.

Copy Envelope

. . . allows you to copy any section of a breakpoint envelope. This command differs from
the Copy command in that it only copies the displayed envelope, and no clips or other
automation.

Paste

. . . pastes the material from the clipboard at the selected location. Material from the
clipboard will be pasted into place regardless of the current selection’s size and con-
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tent. Clips copied from the Arranger View into the Session, and vice versa, retain their
temporal/spatial order.

Paste Time

. . . places copied time into the Arrangement, thereby increasing its overall duration by
the length of time you have copied.

Paste Scenes

. . . works like Paste, but inserts blank scenes before pasting. Live inserts enough scenes
to fit the material from the clipboard. The new scenes will be inserted behind the
current selection.

Duplicate

. . . automatically copies and pastes a selection. This is an easy way to make multiple
copies of a clip or selection of clips. In the Session View, the copies are put into the
slots which follow the selected slots. In the Arranger View, the copies are put behind
the selection, into the “future” of the Arrangement.
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Creating repetition with the
Duplicate command.

Duplicate Time

. . . places a copy of the selected time span into the Arrangement, thereby increasing its
overall duration by the length of the selection.

Duplicate Scenes

. . . works like Duplicate, but inserts blank scenes before pasting. Live inserts enough
scenes to fit the material from the clipboard.

The Session View before and
after executing the Duplicate
Scenes command.
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Duplicate Envelope

. . . duplicates the selected portion of the breakpoint envelope into the Arrangement’s
“future.” Duplicate Envelope can create repeating control movements.

Duplicating part of an
envelope. Notice the clip
remains unaffected.

Delete

. . . erases any selected items. Delete differs from the Cut command in that deleted
items are not placed on the clipboard and cannot be pasted back into place (though
you can undo any command at any time).

If the Delete command is executed while files or folders are selected in the built-in file
browsers, Live will move these items to the system trash. You cannot undo this action
from within Live, but you can retrieve the files from the system trash via the Explorer
(Windows) / Finder (Mac).
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Delete Scenes

. . . deletes all scenes with selected slots from the Session View, thereby reducing the
total number of scenes. Please note that the Delete Scenes command affects all tracks,
not only those containing selected slots.

Delete Time

. . . deletes a selection of time from the Arrangement, thereby moving any audio on
either side of the deleted area closer together in the timeline. This command reduces
the length of your Arrangement by the amount of time you have deleted. Note that the
Delete Time command affects all tracks, not only the selected ones.

Delete Breakpoints

. . . allows you to delete all breakpoints within the selection from the breakpoint enve-
lope that is currently displayed.

Delete Automation

. . . allows you to delete the automation for the selected control. All breakpoints of the
control’s envelope will be deleted.
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Insert Scene

. . . inserts an empty scene below the current selection.

The Session View before and
after executing the Insert
Scene command.

Insert Silence

. . . inserts as much empty time as is currently selected into the Arrangement, before the
selection.

Insert Track

. . . adds one more Clip Track to the Live Set.

Insert Send Track

. . . adds one more Send Track to the Live Set.
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Rename

. . . allows you to rename the selected track, scene, or file. Proceed as follows:

1. select the item you want to rename (by clicking on it, for instance);

2. call up Rename to enter text-edit mode;

3. type the new name;

4. press the Return key to confirm the new name,

5. OR press the Escape key to discard the new name,

6. OR press the Tab key to confirm the new name and proceed to rename the next
track, scene, or file.

Split

The Split command can divide a clip or isolate part of it.

To split a clip in two halves,

1. unfold the track (see Editing Audio Waveforms);

2. in the waveform display, click at the position where you want the clip to be split;

3. execute the Split command.

To isolate a part of a clip,

1. unfold the track (see Editing Audio Waveforms);
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2. in the waveform display, drag a selection over the part of the clip you want to
isolate;

3. execute the Split command to divide the original Clip into three pieces.

The result of splitting a clip.

Add / Remove Slot Button

. . . will add / remove the slot buttons from the selected Session View slots. A slot
button serves two different purposes depending on whether a track is record-enabled
(see Recording Audio) or not:

• if the track is not record-enabled, clicking the slot button will stop the clip
currently running in the track, and disable all track automation;

• if the track is record-enabled, the slot button turns into a record button; click it
to initate the recording of a new clip.

The slot buttons are particularly relevant when working with scenes. Since launching
a scene is equivalent to clicking all clip and slot buttons in that scene simultaneously,
you can pre-configure what will happen upon scene launch by adding and removing slot
buttons. If, for instance, you don’t want scene 3 to affect track 4, simply remove the
scene 3 / track 4 slot button.
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Loop Selection

. . . turns the Arrangement loop on and sets the loop markers to match the selected time
span.

Select Loop

. . . automatically selects all Arrangement time within the Arrangement loop markers.
This is useful if you have edited an Arrangement within the loop markers that you (or
your audience!) find particularly compelling. You can select it all with the Select Loop
command to Duplicate (see Duplicate) or Copy (see Copy) and Paste (see Paste) it, or
to Render (see Exporting Audio (Render to Disk)) it to a new sample.

Select All

In the Arranger, Select All selects the time in all tracks, from the beginning of the first
clip to the end of the last clip.

Use the Select All command prior to rendering (see Exporting Audio (Render to Disk)) to
render the complete Arrangement as a new sample. To accommodate effects like reverb
or delay that may persist after the end of the tune, you can extend the selection beyond
the last clip in the Arrangement by shift-clicking.

In the Session View, Select All selects all slots in all tracks.
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2.2.3 The View Menu

Full Screen

. . . toggles full screen mode.
The Return-from-Full Screen
Button.

To leave full screen mode, click the button that appears in the lower right corner of the
screen.

Under Windows, you can access each menu by pressing the first letter of the menu with
the Alt-modifier held (Alt-F for “File”, for instance). While a menu is open, you can use:

• the arrow up and down keys to navigate the menu items;

• the arrow left and right keys to open the neighboring menu;

• the Return key to choose a menu item.

Commands for Opening / Closing Views

The following commands make Live’s views appear and disappear.

• Info

• Arranger

• Session
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• Clip

• Track

• Bus

• Live Effects

• Plug-In Effects

• Files 1

• Files 2

• Files 3

The following commands hide/show mixer components. You can use different mixer view
setups in the Session View and in the Arranger View.

• Overview (cannot be hidden in the Arranger)

• Clips

• Crossfader

• In/Outs

• Sends

• Mixer
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2.2.4 The Options Menu

Edit MIDI Map

Activates MIDI Map Mode (see MIDI Implementation) for assigning MIDI keys/controllers.

Edit Key Map

Activates Key Map Mode (see Mapping Clips to Computer Keys) for assigning controllers
from your computer’s keyboard.

External Sync

Check External Sync to synchronize Live to an external sequencer. A number of sync
options are available from the MIDI Preferences (see MIDI Preferences).

Time Ruler Format

This selects the time display format used by the Arranger View’s Time Ruler.



2.2. THE LIVE MENU 114

Quantization

A clip launched from the Session View will be quantized according to this setting unless
its launch mode settings (see Quantization and Launch Modes) specify otherwise.

The Quantization Pop-Up.

This setting is reflected by the Control Bar’s Quantization Pop-Up.

Snap to Grid / Quantization

Choose Snap to Quantization to make the mouse snap to the fixed quantization grid that
has been selected in the Option menu, or in the Control Bar’s pop-up menu.

Choose Snap to Grid Lines to make the mouse snap to grid lines that represent meter
subdivisions of the song tempo. This grid adapts to the zoom level.

The Arranger’s Snap to Grid
Switch.

This setting is reflected by the Arranger’s Snap to Grid Switch.

Follow

When the Follow command is activated, the display will scroll while playing to always
show the current position in time. Follow is automatically turned off when you scroll,
zoom, or change the selection.
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The Arranger’s Follow
Switch.

This setting is reflected by the Arranger’s Follow Switch.

Solo Switches

This is the default setting for the mixer’s Solo switches’ operation: soloing a track mutes
all other tracks. The signal from the soloed tracks is heard through their respective
outputs, with the pan setting of each track preserved. Soloing a clip track leaves the
send tracks unaffected (solo in place). Soloing a send track affects all other tracks.

PFL Switches

Using this option, you can pre-listen tracks as though you were cueing a record on a DJ
mixer. This allows choosing clips and adjusting effects without the audience hearing,
before bringing tracks into the mix.

Pressing a track’s Solo switch will route the track’s output signal, tapped before the
mixer volume control (pre-fader), to the audio output you have assigned for pre-
listening (see Pre-Listen). No other tracks will be affected.

The PFL Switches option can be chosen only if your audio configuration supports multi-
ple outputs.

Note that you can adjust your headphone output level using the mixer’s (see Mixing and
Effects) headphone control.
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Preferences

Brings up the Preferences dialog (see Live Preferences).

2.2.5 The Help Menu

Read the Live Manual

. . . launches the web browser with the online Live manual.

Visit ableton.com

. . . launches the web browser with the ableton home page, which offers product news,
artist interviews, interesting downloads and much more.

Join the User Forum

. . . launches the web browser with the ableton user forum, the online venue for dis-
cussing music, software, and Live specifics.
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Talk to ableton

. . . opens an email template for sending your idea, suggestion, wish, clever joke, inter-
esting story, or complaint directly to the makers of Live.

Get Support

. . . launches the web browser with the ableton user support pages. Should you require
help on any issue regarding your ableton product, please follow this link.

Get Downloads

. . . launches the web browser with the ableton download page. Check this link regularly
to determine if a Live update is available.

Get the Full Version of Live

. . . launches the web browser with the ableton online shop, where you can learn about
and purchase the full version of Live.
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2.3 The Live Effects

Live comes with a selection of custom-designed, built-in effects. The “Mixing and
Effects” section (see Mixing and Effects) explains the basics of using effects in Live.

2.3.1 Auto Filter

The Auto Filter effect.

The Auto Filter effect provides a classic analog filter emulation. It can be modulated by
an envelope follower and/or an LFO to create moving filter effects.

There are four different filter types: lowpass, highpass, bandpass, and band reject
(notch). For each type, the X-Y controller adjusts frequency (to adjust, click and drag
on the X-axis) and Q (also called resonance; to adjust, click and drag on the Y-axis).
You can also click on the Freq and Q numeric displays and type in exact values.

Low Q values create a broad filter curve, while higher values introduce a narrow, resonant
peak to the sound. In band pass/reject mode, Q sets the bandwidth of the passed or
rejected signal.
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The Quantize Beat control applies quantized modulation to the filter frequency. With
Quantize Beat off, frequency modulation follows the control source. Turning this feature
on updates the filter modulation rhythmically, with “stepped” changes that track the
master tempo. The numbered buttons represent 16th notes, so, for example, selecting
4 for Beat value produces a modulation change once per beat.

The EnvelopeMod section controls how the envelope modulation affects the filter fre-
quency. The Mod control defines the extent to which the envelope affects the filter
frequency, while the Attack control sets how the envelope responds to rising input sig-
nals. Low Attack values cause a fast response to input levels; high values integrate any
changes gradually, creating a looser, slower response. Think of it as adding inertia to
the response.

Lower Release values cause the envelope to respond more quickly to falling input sig-
nals. Higher values extend the envelope’s decay.

The Auto Filter also contains a Low Frequency Oscillator to modulate filter frequency in
a periodic fashion. The Amount control sets how much the LFO affects the filter.

The Rate control specifies the LFO speed.

Available waveform shapes are Sine (creates smooth modulations with rounded peaks
and valleys), and Sample and Hold (generates random positive and negative modulation
values).

There are two sinewave LFOs, one for each stereo channel. The Phase and Spin controls
define the relationship between these two LFOs.

Phase keeps both LFOs at the same frequency, but can set the two LFOs’ waveforms “out
of phase” with each other, creating stereo movement. At maximum, the LFO outputs are
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180 degrees apart, so that when one LFO reaches its peak, the other is at its minimum.

Spin detunes the two LFOs’ speeds relative to each other. Each stereo channel is modu-
lated at a different frequency, as determined by the Spin amount.

For sample and hold, the Spin and Phase controls are not relevant and do not affect the
sound. Instead, the Auto Filter offers two kinds of sample and hold: the upper sample
and hold type provides independent random modulation generators for the left and right
channels, while the lower one modulates both channels with the same signal.

2.3.2 Chorus

The Chorus effect.

The Chorus effect uses two parallel time-modulated delays to create chorus (thickening)
and flanging effects.

Each delay has its own delay time control, calibrated in milliseconds. Delay 1 has a
high pass filter that can remove low frequencies from the delayed signal. Greater high
pass values let only very high frequencies pass through to Delay 1.



2.3. THE LIVE EFFECTS 121

Delay 2 can switch among three different modes. When Off, only Delay 1 is audible. In
Fix mode, only Delay 1’s delay time will be modulated. When Mod is activated, Delay 2
will receive the same modulation as Delay 1.

To set both delay lines to Delay 1’s delay time, turn on the link button (“= ”). This is
especially useful if you want to change both delays with a single gesture.

The Modulation X-Y controller can impart “motion” to the sounds. To change the mod-
ulation rate for the delay times, click and drag along the horizontal axis. To change the
amount of modulation, click and drag along the vertical axis.

You can also make changes by entering parameter values in the Amount and Rate fields
below the X-Y controller. The Amount value is in milliseconds, while the modulation
frequency rate is in Hertz.

Clicking the *20 switch multiplies the modulation frequency by 20 to achieve more
extreme sounds.

The Feedback control determines how much of the output signal feeds back to the input,
while the Polarity switch sets (surprise!) the polarity. Polarity changes have the most
effect with high amounts of feedback and short delay times.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it
to wet only if using the Chorus in a send channel.
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2.3.3 Compressor

The Compressor effect.

A Compressor reduces gain for signals above a user-settable threshold. Compression
reduces the levels of peaks, opening up more headroom, and allowing the overall signal
level to be turned up. This gives the signal a higher average level, resulting in a sound
that is subjectively louder and “punchier” than an uncompressed signal.

The Threshold slider sets where compression begins. Signals below the threshold are not
processed. Signals above the threshold are attenuated by an amount specified by the
Ratio parameter, which sets the ratio between the input and output signal. For example,
with a compression ratio of 3:1, if a signal above the threshold increases by 3 dB, the
compressor output will increase by only 1 dB. If a signal above the threshold increases
by 6 dB, then the output will increase by only 2 dB.

The red gain reduction meter shows how much the gain is being reduced at any given
moment. The more reduction, the more audible the effect; most pros try to avoid gain
reduction above -6 dB or so if they want a natural sound.

Because compression reduces the volume of loud signals and opens up headroom, you
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can use the Out(put) slider so that the peaks once again hit the maximum available
headroom. The Output meter shows the output signal’s level.

Two controls determine how the compressor reacts to amplitude changes at the input.
Attack defines how long it takes to reach maximum compression once a signal exceeds
the threshold, while Release sets how long it takes for the compressor to return to
normal operation after the signal falls below the threshold.

A slight amount of attack time (5 - 10 ms) allows peaks to come through unprocessed,
which helps preserve dynamics. If these peaks cause overloads, you can try shortening
the attack time, but extremely short times take the “life” out of the signal, and may lead
to a slight “buzziness” caused by distortion. Short release times can cause “pumping” as
the compressor tries to figure out whether to compress or not; while generally considered
an undesirable effect, some engineers use it on full drum kits to give unusual “sucking”
effects.

2.3.4 EQ Four

The EQ Four effect.
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The EQ Four effect is an equalizer composed of four parametric filters. Equalizers are
useful for changing a sound’s timbre.

Filter One can switch among three responses: bell-curve (boosts or cuts over a range of
frequencies), low-shelf (boosts or cuts frequencies lower than the specified frequency),
or low-cut (cuts frequencies below the specified frequency). Filters Two and Three are
always bell-curves. Filter Four can switch among bell-curve, high-shelf (boosts or cuts
frequencies higher than the specified frequency), or high-cut (cuts frequencies above
the specified frequency) modes. Each filter band can be turned on or off independently.
Turn off bands that aren’t in use to save CPU power.

To edit the filter curve, click and drag on one of the filter dots in the XY view. Horizontal
movement changes the filter frequency, while vertical movement adjusts the filter band’s
gain. To adjust the filter Q (also called resonance or bandwidth), hold down the Alt (PC)
/ Option (Mac) modifier while dragging the mouse.

You can also use the numbered filter selector buttons to select a band for editing, then
edit parameter values with the Freq, Gain, and Q dials (and/or type values into the
number fields below each dial).

To achieve really drastic filtering effects, assign the same parameters to two or more
filters, or use more than one EQ Four.

As boosting will increase levels and cutting will decrease levels, use the Gain slider to
optimize the output level for maximum level consistent with minimum distortion.
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2.3.5 Erosion

The Erosion effect.

The Erosion effect degrades the input signal by modulating a short delay with filtered
noise or a sine wave. This adds noisy artifacts or aliasing/downsampling-like distortions
that sound very “digital.”

To change the sine wave frequency or noise band center frequency, click and drag along
the X-axis in the XY field. The Y-axis controls the modulation amount. If you hold
down the Alt (PC) / Option (Mac) modifier key while clicking in the XY field, the Y-axis
controls the noise bandwidth.

The Frequency control determines the color, or quality, of the distortion. If the Mode
control is set to Noise, this works in conjunction with the Width control, which defines
the noise bandwidth. Lower values lead to more selective distortion frequencies, while
higher values affect the entire input signal. Width has no effect in sine mode.

Noise and Sine use a single modulation generator. However, Wide Noise has indepen-
dent noise generators for the left and right channels, which creates a subtle stereo
enhancement.
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2.3.6 Filter Delay

The Filter Delay effect.

The Filter Delay provides three independent delay lines, each preceded by linked low
pass and high pass filters. This allows applying delay to only certain input signal
frequencies, as determined by the filter settings. The feedback from each of the three
delays is also routed back through the filters.

Each of the three delays can be switched on and off indepedently. The Filter Delay
Plug-in assigns delay 1 to the input signal’s left channel, delay 2 to the left and right
channels, and delay 3 to the right channel. The Pan controls at the right can override
the delay channels’ outputs; otherwise each delay outputs on the channel from which
it derives its input.

Each delay channel’s filter has an associated On switch, located to the left of each XY
controller. The XY controllers adjust the low and high pass filters simultaneously for



2.3. THE LIVE EFFECTS 127

each delay. To edit filter bandwidth, click and drag on the vertical axis; click and drag
on the horizontal axis to set the filter band’s frequency.

To refer delay time to the master tempo, activate the Sync switch, which allows using
the Delay time beat division chooser. The numbered switches represent time delay in
16th notes. For example, selecting “4” delays the signal by four 16th notes, which
equals one beat (a quarter note) of delay. With Sync mode active, changing the Delay
Time field percentage value shortens and extends delay times by fractional amounts,
thus producing the “swing” type of timing effect found in drum machines.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit
the delay time, click and drag up or down in the Delay Time field, or click in the field
and type in a value.

Feedback controls how much of the output signal returns to the delay line input. Very
high values can lead to runaway feedback and produce a loud oscillation - watch your
ears and speakers if you decide to check out extreme feedback settings!

Each delay channel has its own volume control, which can be turned up to +12 dB to
compensate for drastic filtering at the input.

The Dry control adjusts the unprocessed signal level. Set it to minimum if using the
Delay in a send channel.
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2.3.7 Gate

The Gate effect.

The Gate effect passes only signals whose level exceeds a user-specified Threshold. A
gate can eliminate low-level noise that occurs between sounds (e.g., hiss or hum), or
shape a sound by turning up the threshold to where it cuts off reverb or delay tails, or
truncates an instrument’s natural decay.

The Threshold slider sets the gate’s sensitivity. If the gate is open and passing signal
(i.e., the signal exceeds the gate threshold), the green LED lights.

The Floor parameter located above the threshold fader can allow attenuating signals
below the threshold rather than just cutting them off. If Set to -inf dB, a closed gate
will mute the input signal. A setting of 0.00 dB means that even if the gate is closed,
there is no effect on the signal. Settings in between these two extremes attenuate the
input to a greater or lesser degree when the gate is closed.

The Attack time determines how long it takes for the gate to switch from closed to
open when a signal goes from below to above the threshold. Very short attack times
can produce sharp clicking sounds, while long times soften the sound’s attack.
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When the signal goes from above to below the threshold, the Hold time kicks in. (Note
to tech heads: the gate has hysteresis, so the release occurs about 3 dB lower than the
threshold.) After the hold time expires, the gate closes over a period of time set by the
Release parameter.

2.3.8 Grain Delay

The Grain Delay effect.

The Grain Delay effect slices the input signal into tiny particles (called “grains”) which
are then individually delayed, and can also have different pitches compared to the
original signal source. Randomizing pitch and delay time can create complex masses of
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sound and rhythm that seem to bear little relationship to the source. This can be very
useful in creating new sounds and textures, as well as getting rid of unwelcome house
guests, or terrifying small pets (just kidding!).

To refer delay time to the master tempo, activate the Sync switch, which allows using
the Delay Time beat division chooser. The numbered switches represent time delay in
16th notes. For example, selecting “4” delays the signal by four 16th notes, which
equals one beat (a quarter note) of delay. With Sync mode active, changing the Delay
Time field percentage value shortens and extends delay times by fractional amounts,
thus producing the “swing” type of timing effect.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit
the delay time, click and drag up or down in the Delay Time field, or click in the field
and type in a value.

You can route each parameter to the XY controller’s horizontal or vertical axis. To assign
a parameter to the X-axis, choose it from the parameter row below the controller. To
assign a parameter to the Y-axis, use the parameter row on the left side.

The Feedback parameter sets how much of the output signal returns to the delay line
input. Very high values can lead to runaway feedback and produce a loud oscillation -
watch your ears and speakers if you decide to check out extreme feedback settings!

You can transpose the grain pitch with the Pitch parameter, which acts much like a
crude pitch shifter.

The Spray control adds random delay time changes. Low values smear the signal across
time, which adds “noisiness” to the sound. High Spray values completely break down
the structure of the source signal, introducing varying degrees of rhythmical chaos. This
is the recommended setting for anarchists.
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The Random Pitch control adds random variations to each grain’s pitch. Low values
create a sort of mutant chorusing effect, while high values can make the original source
pitch completely unintelligible. This parameter can interact with the main Pitch control,
thus allowing degrees of stability and instability in a sound’s pitch structure.

The size and duration of each grain is a function of the Frequency parameter. The sound
of Pitch and Spray depends very much on this parameter.

Grain delay now also has a dry/wet control; it can be routed to the vertical axis of the
XY controller.

2.3.9 Ping Pong Delay

The Ping Pong Delay effect.

The Ping Pong Delay effect uses a single tapped delay line to create a delay which jumps
from the left to the right output.

The delay is preceded by a low and high pass filter which can be controlled with an XY
controller. To define the filter bandwidth, click and drag on the vertical axis. To set the
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position of the frequency band, click and drag on the horizontal axis.

To refer delay time to the master tempo, activate the Sync switch, which allows using
the Delay Time beat division chooser. The numbered switches represent time delay in
16th notes. For example, selecting “4” delays the signal by four 16th notes, which
equals one beat (a quarter note) of delay. This delay time represents the time it takes
for the input signal to appear at the left channel. The delay time between the input
and the right channel is twice as long.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit
the delay time, click and drag up or down in the time field, or click in the field and type
in a value.

The Feedback parameter controls how much of the right channel output signal returns
to the delay line input. The feedback loop also includes a filter which can color the
feedback sound, thus producing different timbres with successive echoes.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it
to full wet if using the Ping Pong Delay in a send channel.
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2.3.10 Simple Delay

The Simple Delay effect.

The Simple Delay provides two independent delay lines, one for each channel (left and
right).

To refer delay time to the master tempo, activate the Sync switch, which allows using
the Delay Time beat division chooser. The numbered switches represent time delay in
16th notes. For example, selecting “4” delays the signal by four 16th notes, which
equals one beat (a quarter note) of delay. If the Sync switch is off, the delay time
reverts to milliseconds. In this case, to edit the delay time, click and drag up or down
in the Delay Time field, or click in the field and type in a value.

The Feedback parameter defines how much of each channel’s output signal feeds back
into the delay lines’ inputs. Internally there are two independent feedback loops, so a
signal on the left channel does not feed back into the right channel, and vice-versa.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it
to full wet if using the Simple Delay in a send channel.
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2.3.11 Vinyl Distortion

The Vinyl Distortion effect.

The Vinyl Distortion effect emulates some of the typical distortions that occur on vinyl
records during playback. These distortions are caused by the geometric relationships
between the needle and the recorded groove. The effect also features a crackle generator
for adding noisy artifacts.

The Tracing Model section adds even harmonic distortion to the input signal. Adjust
the amount of distortion with the Drive knob, or click and drag vertically in the Tracing
Model XY window. To adjust the distortion’s frequency, or “color”, drag horizontally in
the XY window or double-click on the Freq field and type in a value. Holding the Alt
(PC) / Option (Mac) modifier while dragging vertically in the XY window changes the
frequency band’s Q (bandwidth).

The Pinch Effect section adds odd harmonics to the input signal. These distortions
typically occur 180 degrees out of phase, creating a richer stereo image. The Pinch
Effect has the same controls as the Tracing Model, but generates a rather different
sound.
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There are two distortion modes: soft and hard. The soft mode simulates the sound of a
dub plate, while hard mode is more like that of a standard vinyl record.

The stereo/mono switch determines whether the Pinch distortion occurs in stereo or
mono. Set it to stereo for realistic simulation of vinyl distortions.

The Crackle section adds noise to the signal, with noise density set by the Density
control. The Volume control adjusts the amount of gain applied to the noise.

2.3.12 Redux

The Redux effect.

Nostalgic for the famed low-resolution sound quality of the Ensoniq Mirage, Fairlight
CMI, or Commodore-64 computer? Redux returns us to the Dark Ages of digital by
reducing a signal’s sample rate and bit resolution.

The Downsample section has two parameters: “Downsample” and a downsample Mode
switch.

If the downsample dial is set to “1,” every input sample passes to the output and the
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signal does not change. If set to “2,” only every second sample will be processed, so
the result sounds a bit more “digital.” The higher the number, the lower the resulting
sample rate, and the more “deconstructed” the sound. Downsampling is like applying a
mosaic effect to an image: there’s a loss of information, and sharp edges occur between
the blocks.

The Downsample Mode Switch defines if the downsampling either interpolates over a
smaller range (“soft,” down to 20.0 samples), or does not interpolate over a larger range
(“hard,” down to 200 samples).

Bit Reduction is similar, but while downsampling superimposes a grid in time, bit re-
duction does the same for amplitude.

If the Bit Reduction amplitude dial is set to 8, amplitude levels are quantized to 256
steps (8 bit resolution). If set to 1, the result is pretty brutal: each sample contains
either a full positive or full negative signal, with nothing in between.

Bit Reduction defines an input signal of 0dB as 16 bit. Signals above 0dB are clipped,
and the red overload LED will lit up.

Turning off Bit Reduction results in modest CPU savings.
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2.3.13 Reverb

The Reverb effect.

Input Processing

The input signal passes first through high and low cut filters, whose X-Y controller allows
changing the band’s center frequency (X-axis) and bandwidth (Y-axis). Either filter may
be switched off when not needed to save CPU power.

Pre-delay controls the delay time, in milliseconds, before the onset of the first early
reflection. This delays the reverberation relative to the input signal. One’s impression
of the size of a real room depends partly on this delay. Typical values for “natural”
sounds range from 1ms to 25ms.
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Early Reflections

These are the earliest echoes that you hear after they bounce off a room’s walls, before
the onset of the diffused reverberation “tail.” Their amplitude and distribution give an
impression of the room’s character.

The Shape control “sculpts” the prominence of the early reflections, as well as their
overlap with the diffused sound. With small values, the reflections decay more gradually
and the diffused sound occurs sooner, leading to a larger overlap between these com-
ponents. With large values, the reflections decay more rapidly, and the diffused onset
occurs later. A higher value can sometimes improve the source’s intelligibility, while a
lower value may give a smoother decay.

Spin applies modulation to the early reflections. The 2-D control accesses the depth and
frequency of these modulations. A larger depth tends to provide a less-colored (more
spectrally neutral) late diffusion response. If the modulation frequency is too high,
doppler frequency shifting of the source sound will occur, along with surreal panning
effects. Spin may be turned off, using the associated switch, with modest CPU savings.

Global Settings

The Quality pop-up menu controls the tradeoff between reverb quality and performance.
Economy mode uses minimal CPU resources, while First Class delivers the richest rever-
beration.

The Size parameter controls the “room’s” volume. At one extreme, a very large size will
lend a shifting, diffused delay effect to the reverb. The other extreme, a very small
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value will give it a highly-colored, metallic feel.

The Stereo Image control determines the width of the output’s stereo image. At the
highest setting of 120 degrees, each ear receives a reverberant channel that is inde-
pendent of the other (this is also a property of the diffusion in real rooms). The lowest
setting mixes the output signal to mono.

Diffusion Network

The Diffusion network creates the reverberant tail that follows the early reflections. The
decay time control adjusts the time required for this tail to drop to 1/1000th (-60 dB)
of its initial amplitude.

High and low shelving filters provide frequency-dependent reverberation decay. The
high-frequency decay models the absorption of sound energy due to air, walls, and
other materials in the room (people, carpeting, and so forth). The low shelf provides a
thinner decay. Each filter may be turned off to save CPU consumption.

The Freeze control freezes the diffuse response of the input sound. When on, the
reverberation will sustain almost endlessly. Cut modifies Freeze by preventing the input
signal from adding to the frozen reverberation; when off, the input signal will contribute
to the diffused amplitude. Flat bypasses the high and low shelf filters when freeze is
on. If Flat is off, the frozen reverberation will lose energy in the attenuated frequency
bands, depending on the state of the high and low shelving filters.

The Echo Density and Scale parameters provide additional control over the diffusion’s
density and coarseness, and, when the room size is extremely small, have a large impact
on the coloration contributed by the diffusion.
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The Chorus section adds a little modulation and motion to the diffusion. Like the Spin
section, you can control the modulation frequency and amplitude, or turn it off.

Output

At the reverb output, you can adjust the effect’s overall Dry/Wet mix, and vary the
amplitude of reflections and diffusion with the Reflect Level and Diffuse Level controls.

2.4 MIDI Implementation

Live can be controlled remotely from an external MIDI device, such as a MIDI keyboard
or controller box. To assign elements of Live’s user interface elements to MIDI notes or
controller messages:

1. tell Live about the MIDI connection you are using in the MIDI / Sync Preferences
(see MIDI Preferences);

2. activate MIDI Map Mode by clicking the “MIDI” switch in the Control Bar;

3. select a user interface element you want to control remotely;

4. play the MIDI note or MIDI controller that will control the user interface element.

This section describes the details of mapping to the following specific types of Live’s
user interface elements:

A clip in a Session View slot.
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Session View slots. Note that MIDI and computer key assigments are bound to the slots,
not to the clips they contain.

A switch.

Switches, among them the track and effect enable switches, and the Control Bar switches
for the metronome, loop, and punch options.

A radio button.

Radio buttons. A radio button selects among a number of options. One instance of a
radio button is the crossfader assignment section (see Using Live’s Crossfader) in each
track, which offers three options: the track is assigned to the crossfader’s A position,
the track is unaffected by the crossfader, or the track is affected by the cross fader’s B
position.

A contiuous control.

Continuous controls, like the mixer’s volume, pan, and sends.

2.4.1 Mapping to MIDI Notes

• Session View Slots Note-on and note-off messages affect clips in the slot according
to their Launch Mode settings (see Quantization and Launch Modes).

• Switches A note-on message toggles the switch state.
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• Radio Buttons Note-on messages toggle through the available options.

2.4.2 Mapping to Absolute MIDI Controllers

• Session View Slots Controller values above 63 are treated like note-on messages.
Controller values below 64 are treated like note-off messages.

• Switches Controller values above 63 turn the switch on. Controller values below
64 turn it off.

• Radio Buttons The controller’s 0...127 value range is mapped onto the range of
available options.

• Continous Controls The controller’s 0...127 value range is mapped onto the param-
eter’s range of values.

Live supports pitch bend and high-precision controller messages with a 0...16383 value
range. The above specifications apply to pitch bend and high-precision controllers as
well, except that the value range’s center is at 8191 / 8192.

2.4.3 Mapping to Incremental MIDI Controllers

• Session View Slots Value increment messages are treated like note-on messages.
Value decrement messages are treated like note-off messages.

• Switches Increment messages turn the switch on. Decrement messages turn it off.
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• Radio Buttons Increment messages make the radio button jump forward to the
next available option. Decrement messages make it jump backwards.

• Continous Controls There are several conventions used by MIDI hardware manufac-
turers for sending incremental control changes. Each of these conventions uses
a different interpretation of the 0...127 MIDI controller value range to identify
value increments and decrements:

Mode Increment Decrement
Relative (Signed Bit) 65 - 127 1 - 64
Relative (Bin Offset) 65 - 127 64 - 1
Relative (2’s Comp.) 1 - 64 127 - 65

Live tries to auto-detect the convention used when making an assignment. You
can override the setting using the pop-up menu that appears in the Status Line
at the bottom of the Live screen while mapping a Live control.

2.4.4 Sending Controller Messages

Live can send MIDI controller messages to outboard MIDI devices. This is useful when
working with controller boxes that have endless knobs or motorized faders. These
devices need to be updated when a control’s value changes in Live, because the position
of motorized faders or LED chains has to match the new value.

MIDI controller messages will be sent to the Device that is chosen from the MIDI /
Sync Preferences MIDI Control Output Device menu. There is a “Send Control Updates
Now” button that can send the current state of all of Live’s controls after connecting
an external device.
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2.5 Live Keyboard Shortcuts

2.5.1 Managing the Display

Windows Macintosh
Toggle Session / Arranger Tab Tab
Toggle Full Screen Mode F11 F11
Toggle Track / Clip View F12 F12
Hide / Show Track / Clip View Shift F12 Shift F12
Hide / Show Info View ? ?
Hide / Show Overview Ctrl Alt O Cmnd Alt O
Hide / Show Input / Output Ctrl Alt I Cmnd Alt I
Hide / Show Sends Ctrl Alt S Ctrl Alt S
Hide / Show Mixer Ctrl Alt M Ctrl Alt M
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2.5.2 Adjusting Values

Windows Macintosh
Increment / Decrement Up / Down Up / Down
Large Increment / Decrement Page Up / Dn Page Up / Dn
Go Default Del Backspace
Delete Automation Ctrl Del Cmnd Backspace
Type in Value 0..9 0..9
Go to Next Field (Bar.beat.16th) Period, Comma Period, Comma
Abort Value Entry Escape Escape
Confirm Value Entry Return Return

2.5.3 Transport

Windows Macintosh
Play from Start Marker / Stop Space Space
Continue Play Shift Space Shift Space
Play Arranger Selection Ctrl Space Alt Space
Record F9 F9
Go Arrangement F10 F10
Activate / Deactivate Track 1..8 F1..F8 F1..F8
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2.5.4 Editing

Windows Macintosh
Cut Ctrl X Cmnd X
Copy Ctrl C Cmnd C
Paste Ctrl V Cmnd V
Duplicate Ctrl D Cmnd D
Delete Delete Backspace
Insert Ctrl I Cmnd I

By holding down an additional modifier key, some of the above commands can also be
applied to:

Windows Macintosh
Clips and Slots across all Tracks Shift Shift
Time across all Tracks Shift Shift
The Selected Part of the Envelope Alt Alt

Additional Session View commands:

Windows Macintosh
Launch Selected Clip / Slot Return Return
Select Neighbouring Clip / Slot Arrow Keys Arrow Keys
Select all Clips / Slots Ctrl A Cmnd A
Copy Clips Ctrl Drag Alt Drag
Add / Remove Slot Button Ctrl E Cmnd E

Additional Arranger View commands:
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Windows Macintosh
Split Clip at Selection Ctrl E Cmnd E
Loop Selection Ctrl L Cmnd L
Select Time in Loop Ctrl Shift L Cmnd Shift L
Zoom around Selection Plus / Minus Plus / Minus
Auto-Scroll to Follow Ctrl F Cmnd F
Toggle Snap to Quantization / Grid Ctrl G Cmnd G

These commands handle tracks:

Windows Macintosh
Insert Track Ctrl T Cmnd T
Insert Send Track Crrl Alt T Cmnd Alt T
Rename Selected Track Ctrl E Cmnd E
While Renaming, Go to next Track Tab Tab
Reorder Track Drag Header Drag Header

2.5.5 Clip View Sample Display

Windows Macintosh
Move Selected Warp Marker Left / Right Left / Right
Select Warp Marker Ctrl Left / Right Cmnd Left / Right
Move Loop by Loop Length Up / Down Up / Down
Zoom around Loop / Region Plus / Minus Plus / Minus
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2.6 Live’s Copy Protection

Live is protected against illegal use by a copy protection scheme. This scheme has
been designed to meet the highest security standards while avoiding hassles for the
customer. If you find this procedure to be an inconvenience, please understand that the
copy protection secures your investment: it allows ableton to provide you with support
and continue developing Live.

As you start up Live, you will be presented with a dialog that walks you through the
procedure in two steps.

2.6.1 If You do not (yet) Own Live

Live can run in Demo Mode.

If you do not (yet) own Live, you can work with Live in Demo Mode. Demo Mode offers
Live’s complete functionality, but saving, rendering to disc and resampling are disabled.
To run Live in Demo Mode, please click the relevant button.
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Click here if you are
interested in buying Live.

If running Live in demo mode raises your interest in purchasing the full version of Live,
please click the “Buy Live” button or visit the ableton web shop. This site contains
information about ableton’s distributor and dealer network. It also offers you the op-
portunity to buy Live online, in which case you will receive a serial number immediately.

2.6.2 Step 1: Entering Your Serial Number

As an owner of Live, you have received a Serial Number from ableton, either via email
(if you ordered Live directly from ableton), or as part of the Live package. In the latter
case you will find your Serial Number on a sticker on the program CD tray.

http://www.ableton.com/index.php?main=shop
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The Fields for Entering Your
Serial Number.

The Welcome dialog contains six fields to type in the Serial Number. Each field holds
four characters. The Serial Number is composed of numbers 0..9 and letters A..F. If
you accidentally type the wrong string into a field, the field turns red. When you have
successfully entered the Serial Number, click the “Unlock” button to proceed.

The Serial Number identifies your ownership of Live. Because your Serial Number is a
valuable good, you should keep it in a safe place and out of reach of unauthorized hands.
Please be aware that sharing your Serial Number will render it unuseable. The only way
for ableton technical support to help you get back your Serial Number, if you lose it some
day, is via your registration data. Therefore, please register your product, as otherwise
you might lose your property!

http://www.ableton.com/index.php?main=register
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2.6.3 Step 2: Unlocking Live

The second step of authorizing Live is called “Unlocking”. Unlocking means associating
your Serial Number with a specific computer. Please be aware that the standard Live
license grants you the right to use Live on only one computer at a time. You can,
however, unlock Live with your Serial Number more than once, under the legal and
technical conditions described below (see Copy Protection FAQs).

The Unlock Key

For unlocking, you require an Unlock Key that can only be created by the ableton server.
Unlocking therefore requires access to the Internet. The computer from which you
connect to the Internet does not have to be the same computer for which you wish to
unlock Live, but it does make things easier.

The Challenge Code

The ableton server creates the Unlock Key from your Serial Number and a so-called
Challenge Code. The Challenge Code is a “fingerprint” that Live takes of your computer’s
components. For details, please see the corresponding section (see Copy Protection
FAQs).
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Unlocking Online

Unlocking Live Online.

If the computer you want to unlock Live for is connected to the Internet, the only thing
you need to do is press the “Unlock Online” button. Live will then make a connection
to the ableton server, send your Serial Number and Challenge Code to the server, and
receive the Unlock Key from the server. No information other than this is exchanged
between your computer and the ableton server.
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Unlocking Offline

Unlocking Live Offline.

If the computer you want to unlock Live for is not connected to the Internet, you can
use any other computer to access the ableton server’s web interface. This is a web site
with fields for entering your Serial Number and the Challenge Code which you can copy
from Live’s Unlock Dialog.

http://www.ableton.com/index.php?main=unlock
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The Live Unlocking Web Site.

If you have entered your Serial Number and Challenge Code correctly, another web site
will appear to provide you with the Unlock Key. There now are two options for tranferring
the Unlock Key to the computer that is to be unlocked:

1. Follow the web link to download the Unlock Key as a file. Transfer the file to the
target computer via a diskette or CD-ROM. Then, press the Unlock Dialog’s “Load
Unlock Key” button to load the Unlock Key file.
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The Unlock Key can be
downloaded as a text file.

2. OR it might be more convenient to print the web site with the Unlock Key on it.
On the target computer, press the “Enter Unlock Key” button to open a dialog
with fields for typing in the unlock key. Typing in the key is easier than it first
appears because the fields turn red if you type the wrong string.
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Manually enter your unlock
key.
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2.6.4 Copy Protection FAQs

Can I run Live without a Serial Number?

Yes, you can run Live in Demo Mode (see If You do not (yet) Own Live).

What if I Change my Computer’s Components?

If the Challenge Code of your computer changes for some reason, Live will indeed ask
you to unlock the software another time (see Can I Unlock Live more than once?).
The Challenge Code does not change, however, when computer peripherals are replaced
(audio or MIDI hardware; printers; modems). The Challenge Code may change if the
motherboard, or processor, or network card is replaced. On some computers, reformat-
ting a hard drive also changes the Challenge Code.

Can I Unlock Live more than once?

The standard Live license allows you to use Live on only one computer at a time. If you
have registered your product, the ableton server will, however, provide you with two
Unlock Keys in good faith that you will use Live on only one machine at a time. Just
proceed as described inthe corresponding section (see Step 2: Unlocking Live).

You can, therefore, run Live on both a studio desktop computer and a tour laptop,
yet not at the same time. If you are using a Macintosh and switching back and forth
between OS 9 and OS X, you can unlock Live on both systems.

http://www.ableton.com/index.php?main=register
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Should the ableton server reject your demand for another Unlock Key, please contact
ableton’s technical support. They can be reached by:

• E-mail;

• telephone: +49 (0)30 - 288 763 151 (available Monday to Friday 11 to 15hrs CET);

• fax: +49 (0)30 - 288 763 11.

To speed up the process, please:

• make sure you have registered your copy of Live;

• include a brief explanation of the circumstances.

To use Live on more than one computer at a time, you require a Secondary License or
a Site License. ableton offers these licenses at special rates. Please contact the sales
team for details.

Can I play my Set from a Computer that is not Unlocked?

In Demo Mode, you can load and perform a Live Set with no time limitation. You cannot,
however, save changes to the Live Set, resample, or render to disc. When you go on
tour, consider taking along your Live program CD and a CD with the last state of your
Live Set(s). In case of an emergency, you can install and run Live on any computer
available and play your backup Live Set(s).

mailto:support@ableton.com
http://www.ableton.com/index.php?main=register
mailto:sales@ableton.com
mailto:sales@ableton.com
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What do I do about Problems or Questions Regarding Copy Protection?

Please contact technical support. They are happy to help!

mailto:support@ableton.com
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